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Working with gCADPIlus

Here we show how to work with gCADPlus software. Our main focus is on the gCADPlus user interface.

This movie provides a short introduction to the various components that make up the gCADPIlus drawing environment. We cover how to use drop down menus,
using commands to draw lines, circles and other entities, add dimensions and examine landscape productivity tools on the special gCADPlus drop down menu. We
show how to handle floating toolbars, edit entities using the properties box, the importance of the mouse and the value of right clicking the mouse while drafting. We
survey the command and status areas, the mini layer tool, show how to get online help, work with multiple drawings and the multiplicity of layout spaces available
to gCADPlus users. The figure below shows the usual interface. Tip: The drawing editor background is black but can be set to white if desired.

DIMENSION TOOLBAR

FILENAME
STANDARD TOOLBAR y, MENU BAR FORMAT TOOLBAR /

o
® o DRAWING EDITOR OSNAP TOOLS

MODIFY TOOLS

DRAW

Landscape drawings
PROPERTIES are constructed in the
drawing editor area
(dark background)
using tools in various
drop down menus
and toolbar items.

The landscape model
is constructed full
size in drawing units

(mm for the metric
environment) and
decimal feet in the
USA.

.\ O\

MINI LAYER TOOLS LAYOUT TABS COMMAND AREA STATUS LINE
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Key areas in the drawing environment are labeled in the figure above. All the tools necessary to create landscape drawings are in easy reach via drop down menus,
toolbar icons or right click pop up menus. The black area in the figure above is termed the drawing editor (aka model space) and it is here that designs are created using
various tools selected from toolbars, menus or typed in the command area. We think that it is important to maintain consistency in the interface and not to change the
location of menu items or screen layout when new versions of gCADPlus are released - consistency in the use of gCADPlus is our aim.

Viewing a typical design - units and printing from a layout space

The figure below shows a full size landscape model created using decimal feet as the base unit - metric units (mm) can also be used. When complete, the design can
be displayed on any number of layout spaces, each complete with site details and designer’s logo, ready for printing. These views in layout space are most important,
because they provide a quick impression of what the design will look like before printing. The figure below shows an example printed from an architectural C size
layout sheet. Note the inclusion of a plant schedule that is automatically generated using one of the tools in the specialist gCADPIlus drop down menu.

| Be B OH e |@B®

el

O T

A typical landscape plan for a large site in
Massachusetts, USA. The plant schedule
shown on the right is generated automatically.
As each new symbolis added to it is

" - assigned to a particular species name in an
“Mahoney's - accompanying plant data file.
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Creating new designs

New designs can be created in a number of ways - it is possible to start with a blank canvas and use various draw tools to create a base plan and place entities into a
drawing. Alternatively, it is possible to start with a template and simply drag designs, part designs and landscape symbols from a library to complete the drawing.

This movie illustrates some of the various ways in which landscape drawings can be developed.

One of the templates available in gCADPlus. In this case, the site boundaries might be placed at left and the
design ‘dressed up’ by dragging symbols in from the right. That s an easy way to quickly create a design.

. gCADPlus User Guide v2.0 14



Site measurements - creating base plans

Once an understanding of the CAD coordinate system has been gained, it is a relatively simple matter to prepare an accurate base plan taking measurements from a
‘mud map‘ containing actual site measurements made on site.

This movie shows how to make an accurate base plan for a design for the rear of a small cottage.

Tip: We recommend placing the footprint of any building before drawing site boundaries.

Using triangulation to create an accurate base plan ready for a landscape design.

. gCADPlus User Guide v2.0 15



More on the drawing interface - the Properties Box

The Properties Box at the left of screen is a particularly powerful tool. Once an entity in a drawing is selected (using the left mouse button), most characteristics of the
entity - its color, layer, linetype, line thickness, text style and so on can be changed in the box simply by typing new values or selecting from a drop down menu inside
the Properties Box itself. If more than one entity is selected, properties for the whole group can be altered in one fell swoop.

The role of the Properties dialog box when drafting is discussed in this movie.

The Properties box shows all characteristics of a
selected entity. In this case a polyline - a flexible line.
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The use of color

Color in gCADPlus drawings is handled in much the same way as it is in AutoCAD.. Color can be assigned to an individual entity or to a layer. The figure below
shows the color dialog box. This box can be reached from the Format drop down menu or fromat drop down menu or by clicking in the color field of the Properties
box when an entity is selected.

The select color dialog box can
be used to assign a color to the
selected entity. If no entity is
selected, the box can also be used
to set the current drawing color.

When specifying a color, you can enter the neame of a color or its number. gCADPlus uses 256 indexed colors or the color of an entity can be chosen from millions of
true colors defined by a mixture of red, green and blue values.

Setting index colors, true colors, controlling color by layer, color inside plant symbol blocks.

Using true color for subtle shading in landscape designs is achieved using True Colors rather than applying transparency to one of the
statndard 256 color numbers.

. gCADPlus User Guide v2.0 18
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Status line switches

It is common when drafting to use drafting aids. These are built in to gCADPlus. Aids such as as ORTHO forces lines to be drawn in the horizontal or vertical plane.
The POLAR option allows entities to be placed at defined angles (such as 45 degrees) as well as horizontally or vertically. The OSNAP option causes gCADPlus to
jump to geometric points on entities already in the drawing. We will discuss the function of the tools shortly.

The status line at the extreme bottom of the drawing space is most important and controls the behaviour of many editing tools. Drafting can become tricky if you are
not aware what these switches are doing in the background.

This movie explains the use of switches in the status line.

Tip: Especially when learning to use gCADPlus, we recommend selecting these switches one at a time and not making them permanent. It is very easy to turn any one
of these switches on and forget that it is operational. That slows drafting and often forces users to erase entities because they have been wrongly drawn. To aid users,
we have programmed gCADPlus to make the color of a switch red when it is active.

Status line switches - colored red when on. The
current plant data file associated with the drawing is
also shown in the status line

Controls for the POLAR switch

gCADPIlus User Guide v2.0 19
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SNAP

In common with most CAD software like AutoCAD, gCADPlus allows for the activation of an ‘electronic’ grid covering the drawing area. Provided that the
appropriate grid values are set appropriately, this option causes the cursor to jump to grid points when placing entities. The cursor jumps to a grid point when this
switch is on (red). Function key #9 also toggles the snap setting on or off.

GRID
This switch turns the visibility of the electronic grid on or off. As an aid to layout, the grid is automatically turned on when a layout view is activated.

The grid is a pattern of equidistant dots that extends over the drawing. Using the grid is similar to placing a sheet of grid paper under a transparent drawing. The
grid serves two purposes; first, it helps you align objects and visualize the distances between them; and, second, the grid can be used as a snap device, or frame
that entities may drape themselves on. The grid makes coordinate points “visible”. gCADPIlus allows you to set cursor snap to the grid nodes. The cursor will then
move exactly from node to node as you move the mouse.

The grid an snap values are set with the Drafting Settings option which is available by right clicking on the drawing editor. X and Y values for a grid are set along
with a value to determine the grid bold step interval. F7 toggles the grid on or off.

Tip: The grid can be a useful aid when applying dimensioning.
ORTHO

This switch constrains lines to the vertical or horizontal plane. The tracking option can be turned on and off with the F8 key allowing for quick access to the
ORTHO mode. Alternatively, select the ORTHO option in the status line at the bottom of the screen.

POLAR

There are often occasions where designers require lines to be at 90 degrees (orthogonal) to one another or some other angle. gCADPlus has a ‘drawing aid’ called
Polar Tracking, to assist in constructing such lines. Tip: Via the Options dialog box, it is also possible to track at different angles and adjust the step value that
shows as the cross hair cursor is moved.

OSNAP

Object snaps (entity snaps) can be used at any time that gCADPIlus asks for a point. Use an entity snap to locate the new entity accurately at a point on a properly
defined geometric point on an existing entity. For example you might start a new line at the precise center of a circle and use an entity (object) snap to do that.

LWT
It is possible to assign a line weight to any entity. This status line switch controls the visibility of lineweight.
ENT
Controls the display of pop up screen view of extended data added to an entity. See image below.
This movie shows how extra data can be stored with various entities in drawings.
REGEN

This option is used to refresh the screen. There are occasions (for example, after pasting information from the clipboard) when the gCADPIlus display screen needs
to be refreshed.

gCADPIlus User Guide v2.0 20
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The POLAR status line switch

Beginners sometimes find it difficult to distinguish between ORTHO and POLAR. Both enable lines to be drawn orthogonal to one another, but the polar switch is
much more versatile.

This movie illustrates how an understanding of the operation of the POLAR switch and step size switch can greatly speed drafting.

Copying a composting bin at a tricky angle is simplified by creating a new angle in the polar settings dialog box.

Using polar step size to speed
placement of pavers.

gCADPIlus User Guide v2.0 22



N
gCAD*

Plant List
Not a toggle, but the path of any plant data file attached to the drawing is also shown in the status line.

This movie shows how a plant list can be attached to a drawing and how it can be used to generate a plant schedule.

Plant lists can be associated with drawings. The
name of the current list is shown in the extreme
right of the status line.

gCADPIlus User Guide v2.0
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Mini layer tool

Selecting View > Layer puts a box that we have called Mini under the properties box enabling manipulation of layers - this tool replicates what is shown when the
LAYER command is used, but is sown in more compact form. If required, it is possible to float the mini layer windows.

This movie illustrates the use of the mini layer tool.

We discuss the display and operation of the gCADPlus mini layer tool, control display of points and show printing high quality PDF On a Mac.

The Mini Layer tool provides a convenient
mechanism for turning layers on and off.

gCADPIlus User Guide v2.0 24



The symbol library
This drop down menu provides quick access to a wide range of symbols for species planting and other details.

The ‘plants ‘group contains three types of symbols - standard, sized and named. The standard group consists of > 100 stock symbols each 1 meter (3 feet) in diameter,
the sized group contains links to symbols for climbers, grasses, ground covers, hedge, large, medium, small and mini shrubs, small and large trees adjust according

to expected size. The named group contains symbols designed illustrate specific

species. The ‘details’ group leads to symbols for details such as north points,

drawing sheets etc. The ‘designs’ group is provided so you can store completed

design work ready for incorporation into new jobs.

The ‘broadscale’ group is designed for use in large scale projects.

Tip: Selecting a symbol enables it to be dropped directly into a design. Libsreny @i Coe menus el 0 s
the many plant and detail symbols

available in the gCADPlus environment.
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Here we discuss the various ways to use the gCADPlus symbol library.

gCADPIlus User Guide v2.0
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Exploring the interface - getting your hands dirty!

We suggest that the simplest way to start learning to use gCADPIlus is to work with a practice drawing containing some landscape

elements.

Start gCADPlus, select File>New and choose the built-in template called “Funky“. A
based on that template choice will appear containing planting and other symbols on
symbols can simply be dragged into position to make the design.

Before starting, select the distance option found on the standard toolbar (circled
right). Use it to measure the size of the table. The value reported should be full
or feet depending on the version of gCADPlus in use.
Tip: Later you will create your own templates containing all your favorite symbols,
details, dimension and text styles, so new design work can be created efficiently.

Experiment magnifying and reducing the view using the mouse wheel. Roll the wheel

away from you to magnify the view; roll toward you to shrink the view [zoom out].

gCADPIlus User Guide v2.0

new drawing
the right. These

in the figure at
size in either mm

Distance tool.

Create designs quickly
using templates - here
the “Funky” template
in gCADPlus has been
used.
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To pan (move the view of a drawing), hold the mouse wheel down (and keep it down) while moving to a
new position.

Tip: gCADPlus is designed so that you can construct drawings primarily using the mouse. Instructions for gCADPlus to place entities like
circles and lines are selected with the left button of the mouse from drop down or from toolbar icons.

The distance tool shows
the table to be just over a
meter (3 feet) in diameter.

As a further exercise, open the drawing ConstructedWetlandAssemblyPartFinished from the Drawings
folder (In User>My Documents>gCADPlus) and repeat the zooming and panning exercises described above.

[z

7IN

N

%?AQWGQQQ&

VEGETATION BANDS
Constructed wetland ¢
drawing. o
ENERGY DISSIPATION / N
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A quick check print

It is a good idea to gain some appreciation of the appearance of the final printed result at quite an early stage of your design work. gCADPlus provides a flexible
method of producing a PDF file and the file can be created at a number of different resolution settings. Switch to the layout tab labeled Layoutl and select File >Save
As PDF.

Tip: Select Window, Medium resolution, put a box around the area to be printed and ok. The drawing may appear in a PDF viewer such as Acrobat Reader.

This Save As PDF tool provides a quick way to visualize how the design might look in the hands of a client.

The Save As PDF dialog box.
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The importance of the right click menu

After zooming in and out using the wheel of the mouse, try clicking the right mouse button. A pop up menu appears. This
menu provides options for controlling the view of the design and offers access to some additional tools.

Tip: Try selecting an entity with the left mouse button, then using the right button (click option) choose erase. Whenever you are using gCADPlus to create designs;
different options will appear on the menu based on the entity selected.

How to use the right click pop up menus in gCADPlus.

The right click menu - no entity selected. Commands
recently used by you are listed above Zoom Extents.
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Drop down menus
Drop down menus are available at the top of the gCADPIlus screen. Clicking on the title of a drop menu uncovers a series of options (and sub-options).

The majority of drop menus in gCADPIlus, provide the standard features found in most CAD software - tools for File manipulation, Edit, Format, Draw, Dimension,
Modify etc. and are discussed elsewhere. However, the View, Help, Tools and gCADPlus drop down menus contain specialist landscape tools and are briefly
introduced here. More on the gCADPIus menu can be found in Chapter 10 and on the Tools drop down menu in Chapter 11.

Some of the drop down menus in gCADPlus.
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The View drop down menu
For example, selecting the title “View” shows options seen previously in the right click pop up menu, together with quite a number of other tools along with some fly-

out sub menus.

Perhaps the most useful thing to try at this stage in the View drop menu is to select one of Properties, Layers or
Command Line options. One (left) click on any of those, changes the appearance of the screen dramatically by making that
window disappear. A further click causes the zone to re-appear. We have added this capability because users asked for
it. The reason being that experienced users want to be able to use maximum screen real estate when working on designs.

The View drop down menu. Zoom Extents, Window and previous are also on the right click menu, Zoom selected enables a quick zoom to an entity, Regen is used if
the screen is unresponsive, Pan to shift the drawing, Transparent Render shows transparency if set to entities, Pro-perties, Mini Layer and Command boxes can be
toggled on or off, toolbars customized, workspaces saved and background changed from black to white.
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View menu - Workspaces

Worspaces are collections of arrangements of menus and toolbars suited to different drafting styles. For example, the gCADPlus default workspace shows all toolbars,
window zones and menus, while the minimal workspace (shown below) strips everything away except the design itself.

It is possible via the View drop down menu, to switch to, customize and store workspaces. Experienced gCADPlus users like this facility and learn to use numerous
shortcuts to produce landscape drawings. They minimize zooming in and out on a design. They mostly want a minimal, uncluttered drawing interface.

Tip: In order to return to the default view of a drawing when the minimal workspace view is showing, move the mouse to the top title bar, right click and select “Show
menu bar* then select View>Workspace>gCADPlus default.

This movie shows the workspace tool in operation.

Here we have switched gCADPlus to a “Minimal workspace. This option reclaims maximal screen real estate. Since gCADPlus can be
driven by the left and right clicks of the mouse, this can be an efficient way to work, especially on a large site.
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Saving custom workspaces

It is possible to customize toolbars and arrangement of menus and save that arrangement under a name of choice. That choice can be recalled in a later drawing session
(check that changes to toolbars are saved).

Tip: We suggest that you do not experiment with the use of the workspace tool until you have developed your gCADPlus skills to a reasonable level.
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Increment and save

One of the unique features of Computer Aided Design is the length of time you often work on a single design (drawing) file. It’s possible to start on a drawing for a
particular job (let’s call it JohnDoeHouse) and work on it many times over a period of weeks. Even if you save often, there are only two copies of the file in existence
- the native gCADPlus file with its .lcd extension and the .bak version of that same file. With the best intention in the world, no computer, operating system or
application is immune to file corruption so you need to protect that valuable work.

Dialog box used to control backup time. It
is possible to turn off the warning or change
the default time for thois operation.

gCADPIlus offers various levels of protection - an automatic save every 15 minutes to a file with the extension 1c$, error checking etc. However, we believe that the
incremental save tool (found behind the green cross on the standard toolbar) offers landscape designers the best level of protection. Click once on this icon and a copy
of the file is saved under its existing name, and the name of the current JohnDoeHouse drawing file increments and becomes JohnDoeHouse 01. Each time the green
plus sign is clicked, the drawing file increments by one. This means you can have multiple copies of the drawing file and an audit trail. At any time, you can go back
to an earlier version of the design. Our users report that this is a really valuable feature from a design viewpoint - it is not uncommon to head in one design direction
and want to retreat when things do not work out. In that case, all you need do is open an earlier version of your design. The figure below shows the location of the
incremental backup tool (increment and save) on the standard toolbar.

This movie shows how the incremental save feature works.

Incremental backup tool is located on the
standrad toolbar.
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Help while working with gCADPIlus
There are a number of alternative ways to get help while working with gCADPlus.

The ‘Help’ drop down menu

This menu provides a link to the search tool on the gCADPIlus Facebook site. To get help, simply Posts and type your search query in much the same way as you do
with a Google search. A list links to movies will show after the query.

The help options are discussed in this movie.

Press the F1 key or click on the book icon on the standard toolbar next to the right of the AREA tool and the gCADPIlus help file will appear. Note that it is possible to
search for an individual command or search for more general help.

Searching the Help file.
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The gCADPIus drop down menu

This menu provides access to most of the ‘smarts‘ in gCADPlus - the tools used to automate many tedious landscape design steps - attaching plant database files,

setting symbols to a plant name, generating plant list, extracting information, interacting with SketchUp for 3D modelling, a shadow tool, inserting Google Maps and
GIS/GPS tools etc. These are discussed in depth in the file “Automating draftings tasks®.

Some of the automated design tools
available in gCADPlus
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The “Tools’ drop down menu

This menu contains a range of different tools targeted at the basics of constructing landscape drawings - marking areas, alter drafting settings, change draw order of
entities, isolate just those elements on a single layer, create a blank database file, draw hold cloud, link to the DeepRoot online database, check an AutoCAD dwg file
for compatibility, purge a drawing of unwanted blocks, set backup time, create a section, set point markers, insert grid lines, use a section tool, run a sustainability
calculator, gain access to SppDb, the personal plant database designed for use with gCADPlus, merge PDF output files and switch languages.

Isola Madre
- Palazzo
Borromeo

(Italy)

Tools drop down menu (above), sustainability calculator (below)

Use construction lines to creatr sight lines.
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Tools menu - language switching

The figure below shows gCADPlus operating in the French language. Several
different languages are available - French, Czech, German, Russian and Spanish.
Note that not all gCADPIus commands have been translated. We would appreciate
assistance in translating commands to the languages listed above.

Switch gCADPlus commands to French and other
languages.

gCADPIlus User Guide v2.0
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The ‘Window’ drop down menu
This menu allows activity in gCADPlus’s multiple document interface - switching between different drawings, tiling windows etc.

This movie discusses switching from one drawing to another and shows how to copy entities between drawings.

Tip: Use ‘right click’ and select the copy to clipboard option to paste entities from one drawing to another.

Using gCADPlus multiple user interface - switching
drawings via the Window drop down menu.

gCADPIlus User Guide v2.0
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Selecting CAD entities

When using gCADPlus, it is important to understand how to use the various
methods of selecting entities and to manipulate the resultant selection set. Many
drafters do not completely understand that when they ‘pick’ an item(s) in a drawing
using their pointing device, they are creating what is called a selection set. Once a
selection set is created, it can be manipulated in different ways.

Direct selection

This is the simplest method of selecting an entity, just pick it with the left button
of the mouse. The entity is highlighted (in a magenta color) and its properties are
shown in the Properties box window at the left of screen. Note that selections can
be made without responding to a command prompt.

Tip; If you do not like the pick color, a global setting can be used to alter it.

Window selection

You can use a Window-inside or Window-Crossing option to select more than one
entity at the same time. The way a selection rectangle is formed - the direction

in which you define the points of the rectangle (left-to-right or right-to-left)
determines which type of window you create - inside or crossing. This will greatly
influence entities that are gathered in the election set. These two methods of
selecting entities are explained below.

Selecting entities by window-inside
Start gCADPlus, choose File>New and insert a symbol from
the library. After the symbol is in the drawing, select it,
right click and copy to make a group of three similar to
that shown. Click a point in a drawing below and to the left
of a group of (say) 3 symbols as shown below. Click to the
right (and up) to select a second point such that all three
symbols are totally within the selection box.

Result: All three symbols are selected.

Tip: Improving your ability to manipulate selection sets can definitely assist your
CAD productivity. Facility with selection sets is essential if you want be be able
to confidently (an efficiently) use many of the edit commands such as the ERASE,
OFFSET, MOVE, COPY, STRETCH, and BLOCK commands.

Using a Crossing Window

Select a point somewhat higher up on the right and somewhat
lower down on the left as shown. This creates a crossing
window. This time, any entity crossing the window will be

gCADPIlus User Guide v2.0

Example 1: Pick bottom left an
top right

Result: Three entities selected.

Example 2: Smaller rectangle -
only one entity is wholly within
the pick area so is selected.
Result, one entity selected.

d
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selected. Close gCADPlus.

Tip: A window inside box is indicated by a continuous line around the selection box while a crossing window is
indicated by a dashed line.

Selection can also be effected via the Tools menu - several different options are available here.

Example 3: Pick a point
top right (Point A), then
a point bottom left (point
B).

This makes a so-called
crossing window and
all three entities are
selected.

Making selection options from the Tools drop menu.
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More on the value of the Properties box

No matter how you work, the Properties box is a useful aid when selecting
entities. As each entity is selected, its name appears in a drop list in the
Properties box at the left of screen. As shown in the figure, a single pick provides
information in the box about the entity - its type, x and y coordinates, layer, color
etc. in this case, a rectangle is selected.

When several entities are selected, the Properties box changes its appearance
and tells you the total number selected. Shown below where the box tells us that
several entities have been selected. It is possible to scroll down the list of entities
and display information on each in turn. In the figure below, a line has been
selected from a list . Five entities and their properties are now listed.

gCADPIlus User Guide v2.0 43

gCAD*



52

The importance of the Shift and Control keys
(and Global Settings) when selecting entities

Under normal operation, when you select (pick) and entity, its color changes to
magenta to indicate selection. When the next entity is selected, it too is highlighted.
Both the original entity and the new one stay highlighted as do additional entities
selected. If you have several entities selected (perhaps a crossing window has
inadvertently selected an unwanted entity), it is possible to hold down the shift key
and click on the errant entity. It is then removed from the selection set and changes
color. This ‘shift to remove‘ is the default gCADPlus setting; it can be changed if
required.

The control key can also be used to good effect when manipulating selection sets.
Hold it down while a selection set is active and it will enable drawing commands to
continue.

The Control>click sequence on an entity will start the command used to create
that particular entity. Hold Control and click on a piece of text to start the text
command.

The remaining two icons adjacent to the Using Shift button have no effect.

Note that the shift/click response is dependent on the gCADPlus global settings.
See the section in this chapter for information for information about making
permanent changes to gCADPlus’s behavior.

This movie illustrates the use of the Control key click combination to start a
command.

Noun/verb vs. verb/noun selection

If you start (say) the ERASE command (perhaps using the E shortcut) and then
pick (select) an entity such as a circle, you are using the verb/noun selection
system - ERASE (the verb) CIRCLE (the noun). However, rather than issuing

the command first and then responding to it by selecting entities, gCADPlus also
allows the use of verb/noun - selection system. ‘Pick’ the entity simply by clicking
on it (the noun) and then issuing the command (verb). Either system can be used, it
is your choice.

gCADPIlus User Guide v2.0
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Understanding the gCADPIlus coordinate system

In gCADPlus, when a command prompts for a point, you can use the pointing device (your mouse) to specify
a point by clicking, or you can enter a coordinate value on the command line. Coordinates may be entered as
either Cartesian or polar coordinates.

We show how a combination of relative and polar coordinate systems can be used to make a base landscape
plan
In this movie, we show how to draw a paver 800 mm by 600 mm using the different coordinate systems
described below.

Cartesian coordinates

A Cartesian coordinate system has three axes, X, Y, and Z. When you enter coordinate values, you indicate a
point’s distance (in units) and its direction (+ or -) along the X, Y, and Z axes relative to the coordinate system’s
point of origin where all coordinate values are zero (0,0,0). Negative values on the X plane are left of the point
of origin, and positive values on the X plane are to the right of the point of origin. Negative values on the Y
plane are below the point of origin and positive values on the Y plane are above it.

Polar coordinates

Polar coordinates use a distance and a fixed angle to locate a point.

With both Cartesian and polar coordinates, you can enter absolute coordinates based on the point of origin
(0,0,0), or relative coordinates based on the last point specified.

Entering Cartesian coordinates

To use a coordinate to specify a point, enter an X value and a Y value separated by a comma (X,Y). gCADPlus
does not require the use of the 3rd dimension, so it can be ignored even though a value for the Z plane will be 0
- the coordinate set will appear as: (X,Y,Z). The X value is the positive or negative distance, in units, along the

horizontal axis. The Y value is the positive or negative distance, in units, along the vertical axis.

Absolute coordinate values are based on the origin (0,0), where the X and Y axes intersect. Use an absolute CDTTIFFIEIF.IdZ line
coordinate when you know the precise X and Y values of the point coordinate. For example, the coordinate 3,4 From point: -2,1

specifies a point 3 units along the X axis and 4 units along the Y axis from the origin. T p.:.i nt: 3,4

Relative coordinate values are based on the last point entered. Use a relative coordinate when you know the y

position of a point in relation to the previous point. To specify a relative coordinate, precede the coordinate E |

with an @ symbol. For example, the coordinate @3,4 specifies a point 3 units along the X axis and 4 units E 3| 4

along the Y axis from the last point specified. 3 A

The example at right draws a line beginning at a point with an X value of -2, a Y value of 1, and an endpoint at 2L

3,4. Pressing ENTER at the To Point prompt ends the command. KA TEEEEETE
-1
-
Y origin (0,0

. gCADPlus User Guide v2.0




Relative coordinates

The example at right draws a line whose endpoint is 5 units in the X direction and 0 units in the Y direction Command: line

from the start point at the absolute coordinate -2,1. Pressing ENTER at the next To Point prompt ends the From point: -2,1
command. The end result is the same as the first example. To point: @5!(]
Polar coordinates W

. . G
To enter a polar coordinate, enter a distance and an angle separated by an angle bracket (<). For example, 5
to specify a point that is at a distance of 1 unit from the previous point and at an angle of 45 degrees, enter g 3.4
@1<45.

=201 [
Tip: By default, angles increase in the counterclockwise direction and decrease in the clockwise direction. To Y=g TSR EETEE X
move clockwise, enter a negative value for the angle. For example, entering 1<315 is the same as entering 1<- 7~ K \
45. -2
- arigin (0,07

Polar coordinates are either absolute (measured from the origin) or relative to the previous point. To specify a
relative coordinate, precede the coordinate with an @ symbol.

The example above shows a line drawn with polar coordinates (using the default angle direction setting).
Pressing ENTER at the Next To Point prompt ends the command.

. gCADPlus User Guide v2.0



N2
gCAD*

Relative polar coordinates

The example at right shows a line drawn with relative polar coordinates. Pressing ENTER at the Next To Point
prompt ends the command.

Also you can specify direction angle by mouse position relative to last entered point. In this case, you specify
only distance value in the command line, and gCADPlus will use the coordinates of the point which are placed

at specified distance from the last entered point along a direction to cursor position.

gCADPIlus User Guide v2.0
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225* a*
2r0*
Command: line
From point: 0,0

To point. 4<120
To point: 5<30
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Drafting Settings

A variety of precision tools are available in gCADPIlus to help you produce quick, accurate drawings without performing tedious
calculations. Although all your work is based on a coordinate system, you can establish settings that cause you to snap to locations on the
screen, to specified locations on objects, or to points relative to other locations or objects.

Drafting settings can be reached via the Tools drop down menu, by right clicking in the drawing editor and choose Drafting Settings or
by clicking on a toolbar icon. The three tabs available in the Drafting Settings command are shown below viz: Grid, Polar Tracking and
Object Snap

Grid

The grid is a pattern of equidistant dots that extends over the drawing. Using the grid is similar to placing a sheet of grid paper under

a transparent drawing. The grid serves two purposes; first, it can help you align objects and visualize the distances between them; and,
second, the grid can be used as a snap device, or frame that entities may drape themselves on. The grid makes coordinate points “visible”

and gCADPIlus allows you to set cursor snap to the grid nodes. The cursor will then move exactly from node to node as you move the
mouse.

At any time you can turn the grid visibility on/off by pressing F7, or turn grid snapping on/off by pressing F9. This can also be effected by
clicking on the word GRID in the status line. To use a grid, do one of the following:

. Choose Tools> Drafting Settings.
. Right click on the screen and select Drafting Aids and the Grid tab.

. Select Grid from a toolbar.

Tip: The grid can be a useful aid when applying dimensioning.

Polar Tracking and the ORTHO mode
There are often occasions where designers require lines to be at 90 degrees (orthogonal) to one another.
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Object snaps

Object snaps (entity snaps) can be used at any time the program asks you to nominate a point. Use an entity snap to locate the new entity
accurately at a point on a properly defined geometric point on an existing entity. For example you might start a new line at the precise
center of a circle and use an entity (object) snap to do that. Used wisely, entity snaps can take all the hard work out of drafting. Certainly,
one should avoid zooming in on points and placing the start (or center) of a new entity by eye - let the software work for you, not the other
way around.

Putting it another way, entity snaps enable you to quickly select exact geometric points on existing entities without having to know the
exact coordinates of those points. With entity snaps, you can select (say) the end point of a line or arc, the center point of a circle, the
intersection of any two entities, or any other geometrically significant position whenever the software asks for a point location. The
location does not even have to be an entity. You even use entity snaps to draw entities that are tangent or perpendicular to an existing entity.

You can work with entity snaps in one of two ways:

. Enable a running entity snap that remains in effect until you turn it off by choosing an entity snap when no other command is
active or,
. Enable a one-time entity snap for a single selection by choosing an entity snap when another command is active. You can also use

a one-time entity snap to override a running entity snap.

When using entity snaps, the program recognizes only visible entities or visible portions of entities. You cannot snap to entities on layers
that have been turned off or to the blank portions of dashed lines.

When you specify one or more entity snaps, an entity snap target box is added to the cross-hairs. In addition, an icon appears adjacent to
the cross-hair indicating the active entity snap. When you select an entity, the program snaps to the snap point closest to the center of the
target box.

The following snap modes are available;
Center, Near, End, Mid, Node (point), Grip (Quadrant), Tangent, Perpendicular, InsertionPoint, Intersection.

The flyover cursor can also operate and provide an appropriate marker when the geometric point has been found.

Tip: Do take some time to become comfortable with entity snaps settings and the various methods of using them, unless you have a sound
understanding of their operation, they can be counterproductive.

Chapter 4 contains detailed discussion and examples of the use of entity snaps.

gCADPIlus User Guide v2.0
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Function keys

F1 loads the Help file, F2 toggles ORTHO on/off, F3 toggles turns object snap, F7 toggles grid, F8 toggles POLAR tracking, F9 turns snap
to the underlying electronic grid on and off

Formal design based on a very
large circle. Parc St Pierre -
Amiens (France).

gCADPIlus User Guide v2.0
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Tools menu

It is possible to change a large number of environmental variables that apply to individual drawings. The Tools menu is discussed at length
in Chapter 11, but one option - background color will be discussed here as many beginners want to change the background color of the
drawing editor as a first step. Background color is found under Tool>Drawing parameters

We recommend using the switch on the View drop down menu as a quick way of making this change. Leave the model space background
black when you anticipate an extended drafting session to reduce eyes strsin. Then, when you switch from the model to a layout or paper
view, it is immediately obvious which space you are in so there is no danger of inserting a entities in the wrong space.

Configuring Toolbars

Beginners often ask about toolbars. gCADPlus is capable of displaying a number of toolbars. Each toolbar can float and be positioned at
any desired position on the screen. A typical arrangement is shown in the figure below.

The number of icons displayed on an individual toolbar is a function of the screen resolution of your computer system. The wider the
screen, the more icons (with concomitant links to gCADPlus commands) that can be displayed on a given toolbar.

gCADPIlus User Guide v2.0
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More on coordinate systems

In common with other CAD software like AutoCAD, Vectorworks, MicroStation etc., gCADPlus works with a coordinate system. Looking
at the figure below, positive X is to the right in the drawing editor and positive Y up. Entities can be placed into specific coordinate position
and the database keeps track of the position and stores a new set of coordinate values, even if the entity is moved.

This movie discusses the coordinate system used by gCADPlus. We show how to draw line of accurate length using pairs of coordinates
(called Cartesian coordinates) and draw lines of defined length at different angles.

Using Cartesian coordinates in CAD drawings.

gCADPIlus User Guide v2.0
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Beginners often have some difficulty understanding the different coordinate systems available in gCADPlus.

This movie explains the use of absolute and relative Cartesian coordinate systems along with absolute and relative polar coordinate
systems using a typical landscape design file using metric units.

We show how to draw lines of required length in the landscape plan shown
above.

gCADPIlus User Guide v2.0

53


https://youtu.be/QUAR8idtAQo

52

Entering data using Surveyor’s notation.

Landscape architects will often get information about property lines and site boundary information in survey form — notation in distances and bearings.This format is
not utilized on landscape drawings, so some modification needs to be done to gCADPlus drawing settings to enable this capability.

Here is a movie showing how to create a base plan from a drawing where distances and bearings have been used.

Steps
Select UNITS from the format drop down menu.

In the Length Type list box, make sure that Decimal is selected
In the Output Precision list box, leave blank.

In the Anglular Type list box, select Surveyor’s Units.

Make sure that direction is set to counter clockwise.

Pick the OK button to exit the Drawing Units dialog box.

Usage:
Use the LINE command (or preferably the PLINE command)to start drafting the boundary, and utilizing relative polar coordinates to specify the points.

The syntax for the relative polar coordinate and angle is as follows:

Enter the (@ sign first, which means that it is relative to the last point.

Next comes the distance.

The distance is entered in decimal units.

Next comes the < symbol which specifies that the distance is at a polar angle from the last point.

Last is the bearing.

The bearing will always begin and end with a direction — N,E,S, or W.

The actual angle will include degrees (D), minutes (), and seconds (*‘) and must include the appropriate symbols after the number.
An example is @120.25<N30D10’15”E.

Example:
Enter the following information by typing on keyboard exactly as shown:

PLINE (Pick a point with the cursor to start the line)
@120.25<N30d10’15”E

@200.00<N45d12°9”W

@120.25<S30d10°15”W and then select the Close option.
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The BLOCK and BLOCK related commands

Quite soon once users begin to use gCADPIlus, they ask about the possibility of making their own symbols and re-using these and other
grouped entities in drawings. In common with AutoCAD, gCADPlus use BLOCKS to accomodate this need.

Several commands are used to manage the creation, selection and insertion of blocks in the gCADPIus environment viz.
. The BLOCK command itself takes a group of entities and combines them to make a single entity

. The BLOCKS command activates a dialog box to help manage blocks already in a drawing or to add an external drawing from a
disk location.

. The INSERT command is used to select an existing block already associated (loaded) with the current drawing and stamp a copy
into the design. For more information on the insert command, see the section in these notes under “I”.

Each of these ccommands an be activated in a number of different ways - from toolbar icons, drop down menus or by typing at the
keyboard.

How to make a block.

Re-using blocks in other drawings.

The BLOCK command is
used to combine entities

to make a single entity The BLOCKS command

is used to insert symbols. INSERT command.

BLOCKs command
found on toolbar

gCADPIlus User Guide v2.0
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The BLOCK command in the gCADPIlus environment creates a block. Using blocks to stamp copies of (say) a new plant symbol that you
have designed, is much more efficient in terms of drawing file size and managing operations such as zoom and pan than using copies of
symbols made from groups of elements.

Although we often think of a symbol for a plant species as a block, the command can be used to group all types of entities.

The related BLOCKS command is used to access blocks that are already present in the drawing. These may have been made earleir in
the drafting session or imported from the gCADPlus symbol library. Even though not necessarily used in the design, blocks may ‘stay on
the shelf’ ready for later insertion. These unused blocks can bloat a drawing and sometimes make CAD software such as gCADPlus (and
AutoCAD) slow and difficult to use. The PURGE command removes this excess baggage and the drawing more easily managed.

So why use blocks?

A landscape plan made by copying the block to create the plan is much smaller in file size and will zoom and pan more quickly than

one made by copying entities If, as is commonly needed, you need to move a symbol, it is much easier to select a block than pick all the
entities that make up a symbol. That is especially the case when symbols overlap one another. The figure below shows a typical symbol
for a plant species. The top symbol is composed of several elements such as polylines, but these have been combined into a single named
entity - a block. The lower symbol looks identical, but it is made up of individual entities. Blocks have names and if tagged and used to
indicate specific species, help bring landscape CAD drafting alive. This aspect is dealt fully in chapter 9 of this guide.

A block is a single
entity. Copying a block
is much more efficient
than copying a group of
entities

gCADPIlus User Guide v2.0
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Drawing with gCADPIlus

This chapter focuses on the use of common drawing tools needed to create typical landscape drawings. You will ‘learn by doing’ and use various draw commands to
make an accurate, full-size model of a proposal for a space in a garden show. Commands covered include the use of line, polyline, arc and circle commands. Producing
a complete job such as this, even though it’s for a very small site, will arm you with all the skills necessary to develop designs for much larger sites.

Since drawing sheets produced by your landscape design studio will contain contact details, logos and site information, as a first step we will ask you to make a sketch
of a logo and show how to turn it into a CAD drawing. In doing that, we will use gCADPIlus’s flexible line (polyline) command and show how useful it can be in
landscape design work. Once we have made the logo, we’ll move on to the design.

Design for
fireplace setting
by

Ross Ubergang

http://www.
rossu.com.au
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A word on landscape logos

A logo is part of the ‘branding’ of every landscape design business. The logo is
used over and over again in many documents (both in color and black and white),
so it deserves some thought and testing.

The logo and information about the site location, direction of north and scale are
often combined on drawing sheets as shown in the figure below and it is important
to test the logo in combination with other elements.

Logo and title block combination
Tip: For even greater efficiency, text information in title blocks is best organized
as replaceable fields such that inputting details of site location, scale and so on
becomes a straightforward process.
Design elements in landscape logos

The elements in the logo should reflect the philosophy and aims of your business.
Some ideas for logos are shown at right. Note that the font chosen has a profound
influence on the message conveyed.

1.This design is influenced by a cross-section of a trunk with annual rings.

2.This design is meant to indicate an abstract fire pit; encouraging outdoor
entertainment is a specialty of this designer.

3.This logo for a team of landscape constructors who specialize in brick paving.

4.An abstract design for a landscaper whose favorite species is the
Bougainvillea.

gCADPlus User Guide v2.0
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Tip: Not all logos for landscape companies have to relate to a practice competency. The logo below for a company based in Oregon, USA
uses a combination of abstract shapes and text and is shown in the gCADPlus drawing editor. The text dominates, with the green color

used to provide the landscape feel.
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Some more examples of logos for landscape design practices are shown below and to the right.
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Building a CAD version of your own logo

Once you have developed your logo and made a rough sketch, it is useful to have it in several different file formats - as a GIF file for your web site as a high
resolution TIFF file for printed materials, as a colored CAD file and possibly a version in monochrome (Black & White). All of the above can be generated from one
gCADPlus drawing file.

The figure in the title block below shows an example of a logo used by a government instrumentality in a rural area of South Australia. Once drawn, there is no need
to redraw the logo in subsequent plans. It is complex and certainly falls into the category of draw once, use many times. The CAD file of the logo is simply inserted
into subsequent drawings (as a block, often in a title block).

Tip: This approach applies other details like north points, furniture, new planting symbols and even to whole designs.
Raster image versions from gCADPIlus drawings

This movie shows that raster image files (in GIF, JPEG, PNG form etc.) can be generated from a drawing such as the above and used in documents such as word
processing notes and brochures.
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Logo in drawing sheet.
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Exercise: Sketch a logo and make a CAD drawing of it

This movie shows how to trace over a scanned logo for a landscape construction
company using the polyline command.

Tip: do not be too fussy about this, you can easily edit the logo later in your
CAD software application. The steps are:

Scan the logo and save it as a GIF or JPEG file (so it can
be inserted into a gCADPlus drawing). If you do not have
access to a scanner, use your phone and email the image to
yourself.

Start gCADPlus and use the Draw>Insert Raster sequence to
place the scanned logo in a ‘clean’ gCADPlus drawing on
layer zero.

Trace over the logo using the Polyline tool. This functions
much like the line tool that you have used already, but is
more flexible.

Tip: As shown in the movie, use the smooth tools in the Properties box when the
polyline is selected.

Once you have copied the logo, adjust the size of the logo
using the scale command. Make the logo size approximately
25 units by 25 units. Wider is ok.

Save the file as a gCADPlus .lcd file (.lcd is the native file
format for gCADPlus).

This file will be used in a later exercise when developing a title sheet block.

Tip: If you are tracing a complex image to use as a base for your logo, take
advantage of gCADPlus layers as shown in the figure at right. Put each part of
the logo on a different layer.

A logo in a title block on CAD layout
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Exercise: Create a design for a small space

Let’s imagine that you had been invited to design a pop up installation for a garden
display show. The figure above right shows an example of the type of installation
you might have in mind. You saw this design in a Paris park on your recent world
trip and it has sparked a few ideas!

Brief - illustrate ideas for small garden spaces

The organizers of the show have specified that the space available will be 5 meters
long by 3 meters wide. When complete, your design will be presented on an A2
sheet and look something like the one shown in the figure.
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The aim in this exercise is
to recreate this complete
design.
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In this exercise, not only will we show how to create the 2D model step-by-step,
we will build a quick 3D model of the design by exporting to SketchUp and
produce some images similar to that shown below.

This movie shows how to produce the design shown above. It uses one of the
templates available in gCADPlus to speed drafting.

Start gCADPlus.

Select File>New and choose the template termed ‘Funky’.

This template provides a space on the left of screen to set up the design. The
symbols on the right can be used as a ‘drag and drop’ store.

Select the text on the left of screen, right click and
choose the erase option. This action removes the unwanted
text leaving the space clear for a design.

Hold the mouse wheel down and pan to center the view, ready
to create the design.

First draw the boundaries of the site ( which measure 5 meters (5000 units - mm)
by 3 meters. To do that, set a layer as current.

gCADPlus User Guide v2.0

63



N

gCAD*

1. Erase unwanted text.

It is good practice to put boundary information on a
separate layer. As shown in the movie, click on the layer
tool and make the layer L-SITE-BOUNDARY layer current.
This layer was part of the ‘Funky' template so there is no
need to create it again.

Tip: your own templates will contain sets of layer names appropriate to the

style of work you do. It is suggested that preface each layer with L- to indicate a

landscape layer. This helps others who subsequently work with our CAD files.

Set a drawing color
For ease of recognition (and only as a temporary step), set the color of the
boundary layer to red.

Double click on the word ‘Foreground’ in the color column
and change the color to red as shown below. This means
that anything drawn on that layer will be red in color.

gCADPlus User Guide v2.0

2. Set a layer for the site boundary.

3. For ease of recognition while tracing, set drawing
color to red.
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Draw the rectangular base (space) of the display

Select the rectangle tool (choosing the 2 points option)
from the Draw drop down menu (or toolbar).

Set the left (first corner of the rectangle at coordinate
position 0,0 by typing 0,0 in the command area (make sure
you type zero, not upper case O)

Hit the ENTER key and the right, second corner of the
rectangle by typing 5000,3000 and hit ENTER. The result
should be as shown in the figure.
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Place rectangle - select from toolbar
or Draw drop menu.



Select the rectangle (with the left button of the mouse)
Look in the properties box at left and change the linetype

scale from 100 to 1.0.

Tip: The Properties box is a most useful check, but it is more than that. If an
error has been made in typing coordinate values, simply correct the error in the
Properties box.

The rectangle is now a solid line because the linetype scale has been correctly set.

Select the rectangle again and focus on the size value in
the properties box. The rectangle must be 5000 units wide
and 3000 units high and have a center point at X=2500 and
Y= 1500. If not, you need to start again.

Once the base rectangle is correctly placed, it is time to drag various pieces from
the template into position as shown in the movie.

Using the Library drop down menu, place some ‘hardscape’
elements such as timber platforms, tables and chairs and

finally plant symbols into the space. Checking properties of a rectangle.

Tip: Try to match the ‘feel’ of the symbol to the intended species. P Fedy ek ey gl Wi A
momAEnR SN et HES s TR Ln
L T B GO

Create a design by dragging
symbols into position.
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Create a plant schedule

Every landscape design needs a plant schedule. These can take many different
forms - individual plants can be tagged with a text indicator, species can be
identified by their symbol or by the use of the leader command. Experience

has shown that labeling each plant with a leader is not helpful to the client or
construction team as the drawing becomes very crowded. A better solution is to
load a plant list that’s specific for the site involved. Each symbol is tagged and a
tool on the gCADPlus menu does the rest. The number of each species used in the
design is counted and a plant schedule (species list) generated. This saves much
time.

This function utilizes his a companion database called SppDb. This database
enables the generation (export) of a plant data list which can be loaded into
gCADPIlus ready for tagging.

This small movie shows how gCADPIlus and SppDb work together to produce a
plant list.
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gCADPlus can automatically
generate the plant schedule.

Using a plant data
file application with
gCADPlus.
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Download data file

Visit https://www.designcad.com.au/wp/plant-lists/ and
download a copy of the file RossPlantlist.gcp and save it to
your desktop. In the next part of this exercise, you will
load it into gCADPlus.

Return to your design
Select the gCADPlus drop down menu and the Plant Schedules
& Lists option and load the downloaded plant list.

Here is a small movie showing how to load a plant list and generate a plant list
(schedule)

Follow the instructions in the movie to make a plant list.

1. Attach the plant list. Once attached, the list name will
show in the status line.

2. Use the “Set data to plant“ tool to lock each of the
symbols used to a particular species.

3. Use “Show symbols with names™ to check that all symbols
have been coded.

4. Use “Draw the plant schedule” option, nominating a
rectangle in which the plant schedule is to be drawn. The
number of each species used in the design will be totalled.
If extra symbol copies are added, use the “Update schedule™
tool to refresh the list.

gCADPlus User Guide v2.0

Attaching a plant list to a design -
assign species to symbols.

Generating a plant
schedule.
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Tip: For an alternative method of identifying a plant symbol, it is possible
to use the ‘Broadscale’ option on the gCADPlus drop down menu.
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Preparing to print

Although it is possible top print a design from model space, drawings are best printed from a separate (layout) space. In this particular drawing, it is possible to move
to layout space simply by clicking on the tab at the bottom of the drawing editor. This is possible because the template used as a base for the drawing already contains
a layout space. It has been designed for an A2 sheet, so there is no need to create a new one. The figure below shows the layout view.
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This movie shows how to manage the layout and printing of the design.
Improving the presentation in Layout space

This movie shows how to improve the presentation of the design.
Add title block and a landscape design logo

This movie shows how to apply shadowing to plant symbols and produce a
quick PDF version of the design.

BURNLEY LANDSCAPERS

w#  gCADPIus User Guide v2.0
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Additional layouts
In addition to what you have done so far, the client may wish to see:

. A section view

. Elevations on a layout sheet showing the design for the backing screen with a pattern similar to that on
the paved surface.

. Location plan

. A dimensioned drawing complete with accurate setout point data (on a A4 sheet for a construction
team to use)

gCADPlus User Guide v2.0

‘Thank you’ wall
Designer: Ross Ubergang.

www.rossu.com.au
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Constructing a section view

The tools drop down menu contains a link to a section tool. This can be used as an
aid to construct both section and elevation views similar to that shown below.

To add interest, an image file - a strip of ‘sky’has been added to the to the layout
sheet.

This movie shows how to use the section tool in a gCADPIlus drawing.

Section view in model space.

Section view in layout
space.

Title block and logo added in
layout space.
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Elevation view

An elevation view is constructed in much the same way|
as the section view. The plant symbol library contains
some useful symbols although we are sure you would
prefer to make your own.

Tip: The images shown here are taken from a an
alternative design for the same space.

gCADPlus User Guide v2.0
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Return to the design

It is time to draw an elevation view. Landscape designers will often reflect part
of the building into a landscape plan. However, in this example, that idea has
been turned on its head. A design for the screen at the back of the plot has been
made that takes as its main design elements the ‘stripes’ embedded in the paved
area and applies them to the backing board.

Note that the chairs and tables have not been included here. They will add a lot
to our elevation once done.

This movie shows how to adjust the shape of a symbol by changing the x scale
factor.

gCADPlus User Guide v2.0

The Print dialog box. When printing to a
fixed scale, choose print 1:1

Edit title block information in layout
space.
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Print (plot) to a fixed scale

There is often a need to plot to a fixed scale. The image below shows another approach to the design task
described above. The designer wants to plot the drawing out to a fixed scale and then print a check plot on a
local A4 printer.

Here is a small movie showing how to plot to a fixed scale.

To do that, create a new layout using Format>Layout, choosing an A4 sheet in

Type an address, fly to the
site using Google Maps;
copy the image to the
drawing.

v  gCADPIlus User Guide v2.0 7
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landscape view.

Here is the result; the layout has been given a
meaningful name and the dimension layer turned
off. Note that the scale factor in the selected floating
viewport is about 50.

Let’s assume that only a plan view of the design is
required, but the scale factor must be fixed.

Double click into the floating viewport
and set the display appropriate for
the plan view.

Here is the result. Note that the scale factor is close to
20.

To print the design, simply print the
paper option at a scale of 1=1

Tip: It is recommended that a scale bar be included
in model space as a separate check on scaling. Try
and avoid including a scale bar in a drawing sheet
border. If a scale bar is included, great care must

be taken to set the correct scale for the floating
viewport in the Properties box and make sure that
the scale associated with the viewport is fixed. In this
modernage of digital printing, it is easy to print (asy)
and Al drawing on an A3 sheet and inadvertently
change the scale.

Handling title block information

It is better to insert a title block into layout space
rather than model space. The same block can be
included on all layout pages, but easily edited to
adjust information on each sheet while keeping
the same basic information such as logo and site
locations.

This movie shows how to edit title block information
in layout space.

gCADPlus User Guide v2.0

Apply dimensions in plan view.

Apply dimensions in elevation view using multiple viewports.
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Image files

There is often a need to mage files in gCADPIus drawings. These might be used
to indicate a location plan, design ideas and extended data information. It is very
convenient to use Google Maps to find a location, save a screen grab as an image
file and paste the image into gCADPIlus. Street names can be included along with
satellite images to provide a location plan.

Extended entity information can be associated with an entity in a gCADPlus landscape plan

gCADPlus User Guide v2.0

‘Living chess’ by Ross Ubergang.

www.rossu.com.au
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Dimensions

Our model is full size and because it has been drawn that way, dimensions can be taken directly from the model with great ease.In order for this to operate smoothly,
it is necessary to set up a dimension and a layer to accept the dimensions.

Tip: The layer L-DIMENSION may already be present in this drawing.

The next step is to create the dimension style and apply the dimensions as shown in the figure below.

This movie shows how to apply dimensions to entities in the drawing.

Provide construction teams with set
out peg locations.

‘Wood wall’ design by Ross Ubergang.
WWW.rossu.com.au
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Applying dimensions to a section

The figure shows some neatly applied dimensions to a
typical landscape section. [Courtesy of SSensesDesign]

Here is another movie showing how to apply a set
of dimensions to an elevation view from a different
design for the space.

The figure above right shows another example of well
applied dimensions. Here the drawing has been plotted
on an A4 sheet and is not to scale - the dimensions
themselves take precedence over a written scale.

The presentation of this dimension information can
be further improved by including a scale bar (as an
additional check even when a design has been fully
dimensioned) and utilizing the ability of gCADPIlus to
create multiple floating viewports.

Add lighting design

Providing appropriate lighting is an important part
of landscape design work. The symbol and location
can then be passed to programs such as SketchUp in
order to provide a client with a realistic view of the
completed design. This movie shows how the divide
command was used to assist in the location of some
small up-lights for the rear of the upper platform.

We discuss creation of a lighting design.

This movie shows how the extended data tool can be
used to improve lighting design information.

‘Herbs’ - design by
Ross Ubergang.

www.rossu.com.au

v gCADPlus User Guide v2.0

gCAD*



N

gCAD*

Add setout points

The point marker tool can be useful to provide a construction team with guidance to set out a complex paved area. See the example below.

This movie shows how to use gCADPlus to assist a construction team layout out an unusual paved area. It uses the Point Marker tool to provide a list of markers for
pegging the edge of the paving.

Irrigation design
To come.
Export gCADPIlus designs to 3D modelers (SketchUp)

Some clients experience difficulty in understanding 2D plans, even when they are provided with elevation and section views. It is of course, possible to hand sketch
a 3D view, but not everyone has the necessary skill to do that. Many drafters now use software applications such as SketchUp to build a computer generated 3D
representation of the design.

Tip: SketchUp, a tool previously owned by Google, is now owned by Trimble.

gCADPIlus provides a convenient way of exporting base information from a 2D design and bringing it into SketchUp. Building a 3D model is then greatly simplified
because the accurate 2D information from gCADPlus serves as a base for the 3D model.

You have three options for building a 3D model in SketchUp based on 2D information from gCADPlus:

Example of 3D model in
SketchUp.
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(1) Export a graphic and use the free SketchUp application to build a model based on the graphic or
(2) Export a DXF file from gCADPIus and import into free SketchUp (using a plug in to allow DXF importation) or
(3) Use a SketchUp Pro which has the ability to import DXF and DWG files.

Simple 3D. Build a SketchUp
model on a JPEG image
exported from gCADPlus.

Recycled furniture.
Design: Ross Ubergang.

WWW.rossu.com.au
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Option 1

This movie shows how to export a graphic from gCADPIlus and use it in
SketchUp as a base for building a 3D model.
Option 2
Assign a Z value to entities (structural elements) in the gCADPIlus drawing.
Use a “Create SketchUp Layers” tool and export accurate 2D information from

gCADPlus in the form of a DXF file. Entity snap in SketchUp based on the
transferred information is then possible.

This movie shows how to work with option (2) in the SketchUp environment.
Export geometry as a DXF file, import to SketchUp and begin building the
model.

This movie shows how to pass elevation data to SketchUp.

Assign Z values

Use the layer stack tool and isolate just those entities
that you want to work with as a base in the SketchUp
environment (turn off unwanted layers, including the layer
on which plant symbols have been placed).

Select the Make SketchUp layers tool from the gCADPlus
drop down menu.

Assign a Z coordinate to entities if required. In the
example above, the yellow deck was set at 300, the grey
paved area 100 and the white decoration 105.

Select entities (no hatching, no plant symbols, explode
blocks if used to make structural details).

Hit Enter.

Choose whether or not to transfer symbols and text to
another layer.

Start SketchUp and import the DXF file that’s been exported
from gCADPlus. If you have assigned elevation values to
each structural entity, it is a simple task to use the
Push/Pull tool to create 3D geometry.

Use your SketchUp skills to assign materials to surfaces.

Add planting and furniture. An image file taken from the
elevation view in gCADPlus was pasted onto the screen.

Add some textures.

gCADPlus User Guide v2.0

Assign a Z elevation value to an entity prior to export to SketchUp.

SketchUp model based on gCADPlus model.
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If required, the model can be passed to rendering
software for higher resolution and softening. Note
the loss of detail of graphic on the screen wall. This
is a function of the renderer in use. It is possible

to include the graphic on the rear wall in some ray
tracing software.

Some clients may benefit from seeing an animation
of the proposed design.

gCADPlus User Guide v2.0

Export DXF from
gCADPIlus to SketchUp.

Export dwg file from
gCADPlus.
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Precision drafting ~ using entity snaps effectively

Imagine that your design calls for an accurately placed sight line similar to that shown in the figure below. The line runs through the center of a group of pavers

and through a central point in a water feature. The sight line has been drawn in gCADPlus using a construction line entity and runs from the main path with an
ornamental pond as a focus. It starts at a known midpoint on the edge of the path (labeled midpoint) and passes through the mid point of each paver and through the
center of the pond. An ornamental water feature is specified and your construction team needs some accurate set out (peg points) to loacte the feature. That means
the construction line must be precisely placed so setout points can be extracted. Placing the line ‘by eye’; not good enough in this instance! Accurate location can be
dealt with only by using entity snap (osnap) tools in gCADPlus to accurately place new lines and other entities by ‘snapping’ to existing geometry in the design.

This movie shows the use of entity osnaps using some landscape examples.
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Using these entity snap tools, it is possible to produce landscape drawings with considerable speed and accuracy. When snaps are used, there is no need to zoom in and
place entities by eye; a technique that often results in small gaps in drawings. Instead, entity snap functions are used to set location for the entity being placed. These
snaps are versatile and give gCADPlus the ability to snap to a wide range of ‘geometric’ points (or handles) on entities in the drawing. Any time the software asks for a
“To point* these snaps can be used to locate a position.

Every entity placed in a gCADPIlus landscape drawing has a number of defined snap points. For example, it is easy to jump to the mid or end point of a line, the center
of a circle or the center of an arc. These points are indicated by ‘handles’ or ‘grips’ that vary according to the type of entity. The figure below that shows most of the
‘primitive’ entities in gCADPIlus and their respective handles (or grips).

This small movie shows how handles and the entity snap system works in the gCADPlus environment.
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To reiterate, entity snaps enable quick selection of exact points on existing entities without needing to know the exact coordinates of those points. You start a command
- for example the LINE command, and select a start point(say) the end, then locate a destination point on a line, arc, the center point of a circle, the intersection of any
two entities. The location does not even have to be an entity. Entity snaps can be used to draw entities that are tangential or perpendicular to existing entities.

The following entity snap ‘jump’ points are available: Center, Near, End, Mid, Node (Point), Quadrant (Grip), Tangent, Perpendicular, Near, Insertion, and Intersection
Using entity snaps - an example

Suppose two circles indicating a water feature need to be positioned centered on the end of a distribution pipe for a water feature as shown in the figure below.

This little movies show how this drafting step could be done using osnaps and existing geometry.

Moving two circles from one point to another and
placing with the aid of an entity snap - osnap.
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Precise positioning is managed by selecting the circles, right click and choose the move option. When asked to nominate a base point for the move, it is possible to
select the Snap to Center option from the Osnap tool bar (shown below), and in response to the “move to“ prompt, use the midpoint option from the tool bar to locate
the circles accurately at the end of the rectangle representing the distribution pipe. The result is accurate location, no coordinate positions are needed. Everything flows
from existing geometry.

The osnap ‘Near’ option

Let’s take another example, using a different osnap (entity snap) options- the Near option. This particular esnap enables the software to lock onto an entity (e.g. a line).
The cursor sticks to the line and the final location of the “to point* can be set by sliding the cursor along the line. The “to point” is locked to the line when the left
mouse button is clicked.

This movie illustrates the use of the osnap nea option.

Tip: The nearest option is a misnomer. It does not mean that the “to point” is somewhere near the entity you point to, it is right on the money!
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The figure below shows the nearest option being used to copy a symbol along a line to indicate a formal row of trees or shrubs.

Using the “Near* option to locate a symbol on top of a construction (or
perhaps an irrigation) line.
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An alternative method for setting osnap options

In the examples shown thus far, the required entity snap has been selected from the osnap tool bar each time it is required. However, an alternative, and much more
efficient method when asked for a ‘to point’ is to simply right click and choose ‘snap overrides’.

Using the right mouse menu to select the
required osnap setting.
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Snapping to the quadrant of a circle - the Grips option
It is not immediately obvious, but the grips osnap option allows snapping to each of the four quadrants of a circle (or part of a circle - an arc). Consider the design
below. As part of a quasi formal design, this landscape designer wanted a construction line to start from a quadrant of a circle to run through the mid point of the path.

The grips (or quad osnap) allows that to happen smoothly.

Using the grips option to locate a ray starting at the
quadrant of a circle.
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Running osnaps

So far, each osnap selection that we have made has been a single ‘one -off* selection. However, there are times when you will want a snap selection to stay active;. In
this case, set a running osnap. The Drafting Settings dialog box - the osnap tab - can be used for that purpose. To activate it, right click in the drawing editor and select

drafting settings and the osnap tab. The resulting dialog box is shown below.

Tip: The object snap settings box can also be reached via the osnap tool bar and the format drop down menu.

Running osnaps vs. single use osnap
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To set a running osnap, select the first tick box - “Object snap on®, then select the required osnap - end, int, node etc.
Tip: Note that the F3 function key is a toggle for switching running osnaps on or off-

Tip: Try and minimize the number of option boxes you tick. If you run with a lot of snap options on at the same time, the software will spend far too much time hunting

for handles on elements in the drawing. This is particularly a problem in crowded areas of the drawing. You may well find that the to point is not where you expect it to

be simply because the software has jumped to a handle that you did not see.

Visual clues to osnap operation Q
Osnap o
OA O & X b T X O X0 i

If an osnap is in operation, the tab on the status lines shows as pressed in. One press on the F3 key takes it off .
To ‘tweak’ the osnap settings on the fly, click the magnet option.
Osnap indicators

When an osnap is selected, and you move close to an entity in the drawing with an appropriate handle, a magenta colored marker shows.

Tip: To alter the size (and color) of the marker go to Global Settings on the Tools drop down menu. The size if the aperture box that the software uses to locate the
appropriate osnap handle can also be changed in this way.

Why this emphasis on the use of osnaps?

gCADPIlus is more than a replacement for a drawing board. When laying out a design, it helps you create an accurate full size model of the real landscape. Because the
software builds the model to a high level of accuracy (using osnaps), key information can be extracted. For example:

. Dimensions are not applied by scaling off a ruler, they are drawn (taken) from the model itself. This provides a high level of security that the design can be
properly constructed.

. Quantities can be extracted from a drawing answering questions such as what volume of mulch is required to cover a bed to a specific depth.

. A setout point table can be prepared that enables a construction team to quickly mark out the site.

None of the above is possible unless you master the use of entity snap settings.

This emphasis on osnaps applies whether you are placing entities or editing a drawing. Many edit commands require you to anchor points (e.g. the base point in a
MOVE operation) accurately. This is best done by the use of entity snaps. Badly drawn CAD drawings often show small gaps between entities and this can cause all
sorts of problems, especially when applying hatching. Entity snaps enable you to quickly select exact geometric points on existing entities without having to know the
exact coordinates of those points. With entity snaps, you can select (say) the end point of a line or arc, the center point of a circle, the intersection of any two entities,
or any other geometrically significant position whenever the software asks for a point location. The location does not even have to be an entity. You even use entity
snaps to draw entities that are tangential or perpendicular to an existing entity.
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Modifying designs
This chapter covers the use of common editing commands available in the gCADPlus Modify drop down menu, the command line and on the modify toolbar.

Tip Do not forget that whenever an entity is selected, many of these editing commands are available from the right click ‘pop up ‘ menu.

When an object is selected and ready for the operation of a
‘modify ‘ operation, the entity shows in a magenta color.

gCADPIlus User Guide v2.0
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The Erase command
Used to remove an entity from drawing editor. To erase an entity, do one of the following:
. Select the entity and right click, then choose Erase.

. Type E in the command area and press ENTER. SV $ & 0 Ak A e = |_-:"l [ & J i ?1 =
. Type ERASE in the command area and press ENTER.

. Select the object and select the scissors tool on the standard toolbar.
. Select the enity and hit the DEL key.
The Copy command
Makes a copy of an entity or group of entities. To copy an entity, do one of the following:
. Choose Copy from the Modify drop down menu (do not choose the CopyToClipboard option)
. On the Modify toolbar, click the Copy tool.

. Type COPY in the command line and then press Enter.

A S O B Ak St = [0 L @ o T e

. Select the entity right click and select Copy.

When asked for a base point, select a point on the entity to be copied. Then hit ENTER

Follow this an indicate the point of displacement.
Tips: Beginners often fail to mark the base point correctly - it need to be directly on the entity to be copied.

Right click in the middle of the copy command in order to control whether or not to multiply the copy, specify the displacement, input a pair of coordinates or call up a
snap override.

Use copy together with Tracking. Set additional tracking angles as required.

The COPY command can be used to generate a circular array. Hold the SHIFT key down while copying around a center point. More on the use of the copy command
can be found on YouTube - type ‘e¢CADPlus copy’in the search box.

Use copy and copy 400mm pavers a fixed distance.
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Move

An entity can be moved from one position (selecting a base point) to another using the move command. The entity (or group of entities) is shifted from one location to
another. To move an entity, do one of the following:

Choose Move from the Modify drop down menu (do not choose the CopyToClipboard option) or,
on the Modify toolbar, click the Move tool, or

type MOVE or M in the command line and then press ENTER, or & o oRal e =y |—-.Ilt [ J i ?1 -
-’ E —+
Select the entity right click and select Move. ' '

Here is a short movie showing the use of the move command in operation.
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Rotate
The ROTATE command spins an object(s) about the Z axis. To rotate an object, do one of the following:
Choose Rotate from the Modify drop down menu.

On the modify toolbar, click the Rotate tool. &Sy L] Al s e = [ L] & FF B ™
Type ROTATE or RO in the command line and then press Enter.

Select the entity right click and select Rotate.

Tip: The ROTATE command can be used to generate a circular array. HThis small movie illustrates the use of
the ROTATE command.

More example of the use of the rotate command can be found on YouTube - type gCADPlus rotate in the
search box.

Right click in the middle of
the ROTATE command for
more options.
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SCALE

The SCALE command can be used to make an object (or group of objects) smaller or larger. To scale an entity, do one of the following:

Choose Scale from the Modify drop down menuln gCADPlus, the SCALE command is commonly used to scale symbols representing plant specimens. If you are
working in the USA, the symbols in the drop down menu Library > Plants > Standard group are drawn with a canopy diameter of 3 feet. If you are working in the
metric system, the canopy diameter is 1000 mm. As a symbol is inserted, you have the ability to scale the drawing as it is inserted. Typing a factor of 2 in the USA
system where the base unit is decimal feet brings the new symbol in with a canopy diameter of 2 X 3 feet, i.e. 6 feet. Similarly, in the metric version of gCADPIlus, a
scale of 2 results in a symbol 2000 units (mm) wide - 2 meters.

This small movie shows how the scale command can be used in a drawing where the base unit is decimal feet.

It is worth experimenting with scaling symbols dynamically as shown in the movie. Select the symbol, respond to the prompts by marking a base point (in the center
of the symbol is best) when asked for the scale factor or reference point, move your cursor to the edge of the canopy and click, finally drag in to reduce the size of a
symbol or out to increase its size.

The symbols available in the Library > Plants > Sized groups ( Climbers, Grasses, Ground Cover, Hedge, Large Shrubs, Medium shrubs, Mini Shrubs, Small Trees,
Tall Trees have already been sized, but that does not preclude the use of the SCALE command to further adjust canopy diameter..

On the modify toolbar, click the Scale tool.

Type SCALE in the command line and then press ENTER.

Select the entity right click and select Scale from the pop up menu.

Scaling can be dynamic (drag) or type a value in the command line. Values > 1.0 magnify the enity and values <1.0 shrink the object.

Tip: Whole drawings can be scaled. We prefer to scale about coordinate 0,0 as a base point if scaling and entire drawing. More options
are available on the right click pop up menu in the middle of the SCALE command.
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In gCADPlus, the SCALE command is commonly used to scale symbols representing plant specimens. If you are working in the USA, the symbols in the drop down
menu Library > Plants > Standard group are drawn with a canopy diameter of 3 feet. If you are working in the metric system, the canopy diameter is 1000 mm. As a
symbol is inserted, you have the ability to scale the drawing as it is inserted. Typing a factor of 2 in the USA system where the base unit is decimal feet brings the new
symbol in with a canopy diameter of 2 X 3 feet, i.e. 6 feet. Similarly, in the metric version of gCADPlus, a scale of 2 results in a symbol 2000 units (mm) wide - 2

meters.
This small movie shows how the scale command can be used in a drawing from the USA where the base unit is decimal feet.

It is worth experimenting with scaling symbols dynamically as shown in the movie. Select the symbol, respond to the prompts by marking a base point (in the center
of the symbol is best) when asked for the scale factor or reference point, move your cursor to the edge of the canopy and click, finally drag in to reduce the size of a

symbol or out to increase its size.
The symbols available in the Library > Plants > Sized groups ( Climbers, Grasses, Ground Cover, Hedge, Large Shrubs, Medium shrubs, Mini Shrubs, Small Trees,
Tall Trees have already been sized, but that does not preclude the use of the SCALE command to further adjust canopy diameter..
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Scale entire drawings - troubleshooting
A gCADPIlus user working on a project in the USA had difficulty getting sensible values when the AREA command was used. With a little

detective work we were able to determine that the design had been scaled by a factor of 12 (perhaps an attempt to convert feet to inches).

All gCADPlus designs should be full size. In the USA, we work in decimal feet - the standard arrangement when the default drawing is
used as a base for a new design. The only change that possibly needs to be made to drawing settings in a new design is to the dimension
style. We have included in the default drawing a dimension style called 1/96. That should work for most situations.

gCADPIlus User Guide v2.0
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Mirror

This command is used to gather a group of entities and to copy (mirror) them about a mirror line. To mirror an
entity object, do one of the following:

Choose Mirror from the Modify drop down menu. P =
On the modify toolbar, click the Mirror tool. é Gé' ‘-I-' O bl @fh -"'{ e |_"" [d] & '{ Ii" I;i" tl |
Type MIRROR in the command line and then press ENTER.

Select the entity right click and select Mirror.

Here is a short movie showing how the mirror command can be used to rapidly build up a design for part of
an entrance portico. We show how to handle text when using the mirror command.
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Mirror entities - set a copy option if required.
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Explode

The EXPLODE command allows you to change a grouped item into its individual elements so it can be edited. Putting it another way, The EXPLODE command
breaks a compound object like a BLOCK or even an entire drawing up into its constituent parts (separate entities).

To explode an object, do one of the following:

Choose Explode from the Modify drop down menu.

On a toolbar, click the Explode tool.

Type EXPLODE in the command line and then press Enter.
Select the entity, right click and select explode.

A word of caution - if complex objects like hatching are exploded, the file size of the drawing may increase dramatically.

This small movie illustrates the use of the explode command.
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Join

The Join command can be used to stitch together a series of individual entities such as line segments into one polyline entity. This makes operations like hatching so
much more convenient.

To join an entity object, do one of the following:

Choose Join from the Modify drop down menu.

On the modify toolbar, click the Join tool.

F 98D OB AR G L& T

Type JOIN in the command line and then press ENTER.
Select the entity right click and select Join.

We use the JOIN command to weld together several lines. The resultant polyline is then easily hatched.

In the figure below, the Join command can be used to weld the line and the arc (because they have the same endpoint).

Join line and arc to
make a polyline.
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Trim

The TRIM command can be used to clean up overhanging entities over a boundary. To trim an entity object, do one of the following:

Choose Trim from the Modify drop down menu.
On the modify toolbar, click the Trim tool.

Type TRIM in the command line and then press ENTER _g# =& «b &) 5] Ab (o)=2 [0 L] & &5 B 3 ™

We trim several overhanging lines and create a new layout to display a design for the front entrance of a house.

Trim overhanging
entities.
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Extend

This command enables entities to be extended to a boundary. Start the command with a menu item, a toolbar icon or by typing the command. The first prompt asks for
the boundary to which the entity is to be extended, right click, then choose the entity to extend.

To extend an entity to a boundary, do one of the following:

Choose Extend from the Modify drop down menu.

On the modify toolbar, click the Extend tool.
=] + 7
Type EXTEND in the command line and then press ENTER. # %% O B AN A A W& F W )

Here is a short movie illustrating the use of the EXTEND command.

Extend one or more
entities to a boundary.
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Offset

The OFFSET command makes copies of object(s) parallel to the current position at a distance you nominate. The lines at right and top have been offset 230 mm to
create a double brick wall.

The offset command can be started by:

Choosing Offset from the Modify drop down menu. & 93 oI 8 B A Sto=y [T ClE ) | T
Type OFFSET or O in the command line and then press Enter.

Select the entity, right click and select Offset.
Select from a toolbar option.

You will be asked for an offset distance. Type the distance in the command area and hit <ENTER> or select the ‘Through’ option and simply click the point in the
drawing where you want the offset to appear.

This short movie shows the offset command in action in the metric environment.

This short movie shows the offset command in action in the Imperial environment.

Use a pop up menu
item to set the offset
distance.
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ARRAY

This command creates copies of objects arranged in a pattern.It is possible to create copies of objects either in a regularly spaced rectangular or polar array. A

rectangular array distributes copies of the selected object into any combination of rows and columns while a polar array evenly distributes copies of the object in a
circular pattern around a center point or axis of rotation

Creating a polar array.

Using the array command to quickly place some bricks around a garden bed. We create a rectanglar array.

Create the design shown below.
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STRETCH

The STRETCH command is poorly understood by CAD users. It allows you to adjust/move objects like a
door or a window along a wall with little effort. It is a little tricky to use and the most important thing to keep
in mind is to start with a crossing window at the first prompt. Perhaps you are already using Stretch without
knowing it. If an entity such as a line is selected and you click on a handle to make it hot, moving the handle
utilizes the stretch command without the need to call it.

To STRETCH, do one of the following:

Choose Stretch from the Modify drop down menu. $93 5 O 5] Ab A gl = [1& 4 WP

On the modify toolbar, click the Stretch tool.

This movie illustrates theh use of the STRETCH command.

Here is a short movie illustrating the use of the STRETCH command.

Simplify editing with the
STRETCH command.
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BREAK

The BREAK command slices a segment from an entity such as a line.

To BREAK and entity, do one of the following:

#2820 H M AFATADEZ W BT

Choose Break from the Modify drop down menu.
On the modify toolbar, click the Break tool

This movie shows the break command in action. We break twice at a point on a line to remove a doubled up
segment.

Remove a segment from a line or polyline entity with
break.
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EXPLODE

The explode command is usually used to break a complex, compound symbol or group of entities (a block) into
a separate set of entities that made up the block.

The explode command can be started by:
Choosing Explode from the Modify drop down menu.
Type Explode or X in the command line and then press Enter.
Select the entity, right click and select Explod & QL
elect the entity, right click and select Explode. = =
. 4B DA MAFALIEE) BRBE
Select from a toolbar option. :

The figure below shows a complex block (plant symbol) highlighted in magenta with a single pick, and a copy
of the symbol exploded on the right where a single click selects one entity.

The EXPLODE
command break
compound objects into
constituent parts.
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Explode polylines
This command allows you to edit a section of a continuous polyline by “exploding” the line and morphing it
into individual lines. This command is important, as it lets you select certain areas of a line without selecting a

whole shape.

The figure below shows an intact polyline with three vertices on the right with an explode polyline on the left.
There are so many individual segments that editing the polyline becomes exceedingly difficult.

Exploding a polyline.
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FILLET

The fillet command enables users to create a rounded corner (or fillet) between various entities such as lines,
polylines, arcs etc. by extending them, then trimming.

It is well worth experimenting with the FILLET command in gCADPlus. It can save much editing time. For
example, the fillet command can be used to square off a corner in one click without the need for a double trim.
Alternatively, the resultant corner can be given a radius.

This movie shows the FILLET command in action.

FILLET RADIUS OA\\ RADIUS ZOOA\\

RESULT RESULT
N\ N\

The fillet command can
be used to clean up
corners.
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ORDER command (Draw order)
gCADPIlus provides DRAWORDER tools to allow control over the stacking order of entities. Although we
have placed the options in the Tools drop down menu, it is available via the Modify toolbar.

One (entity) object can be set to lie under or above another if required. Options are: send to the back, bring to
the front, and for more subtlety, send above or below an entity.

These small movies shows some of the issues involved in the use of the draw order tools.

The tall tree symbol is
above the understory
planting (and paving).
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DIVIDE

If you have been used to drafting with AutoCAD, you may have used the DIVIDE and MEASURE commands.
We have not implemented a measure command because measuring along a line or other entity a fixed distance
in gCADPlus can be carried out easily using tracking, but a DIVIDE command is another matter.

A DIVIDE command is available in gCADPlus and it is called from the modify drop down menu. The first
prompt asks for the entity to be divided and the second asks for the number of segments. The line (or other
entity) is then divided by placing appropriately spaced points along the line.

Dividing a line into a
number of equal length
symbols

Tip : You may need to adjust the size of the point marker if the divisor points do not show clearly. This is done
from the Format drop down menu.

Here is a short movie showing how the DIVIDE command is used. We show how to space lighting an equal
distance apart in a low voltage supply line

gCADPIlus User Guide v2.0
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ELEVATION

This command stores the Z value with an entity. For example, if a rectangle used to denote a raised
paved area is assigned an elevation of 300 mm (when working in metric base units, 1.5 feet when
working in imperial units) then when the drawing is passed to SketchUp to build a 3D model, the
rectangle will automatically placed at that level. This greatly speeds up 3D model making.

Setting an elevation value in
gCADPIlus makes for easy
model building in SketchUp.

Passing elevation data to SketchUp

v gCADPlus User Guide v2.0 117

gCAD


http://youtu.be/LdmfAWhZyFE

gCAD*

Set fixed scale

It is usual to print drawings from layout space. The scale within a floating viewport on a layout sheet is set in
the properties box. Changing the scale factor to meet standards like 1/96, 1/100, etc. can get a little trick. This
command allows for selection of a desired scale directly from the command line.

Fixed scale off

This command clears a scale setting associated with a floating viewport.

Set scale factors in floating
viewport frames is simplified
with this tool.

gCADPIlus User Guide v2.0
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MATCH PROPERTIES

This tool is used to select an entity, capture its properties and apply the same set of properties to one or more
other entities. It is a great time saver when editing.

Select the option from the Modify drop down menu, indicate a source entity, and then an entity to be matched.

A movie showing the operation of the Match Properties tool. the colour and layer properties of one set of
hatching in a bush regeneration mix is applied to other hatched areas.

MatchProperties - one of the most
valuable editing tools in gCADPlus.

gCADPIlus User Guide v2.0

119


http://youtu.be/C6Cj6fsIIvg

Align objects

If there is a need to lining up a group of entities when drafting - the underground water tanks in the example below - this ALIGNOBJECT
tool can be used.

This movie shows how to use the align command to simplify the placement of a group of underground water storage tanks.

Align objects - command line options

Aligning a group of
objects (entities).
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Align text

This command is used to line up text. Various options such as left and right justify are available.
Tip: the tool works well in layout space and can be used there to neaten up the text in a presentation sheet.

This very short movie shows the AlignText tool in action in layout space.

Aligning a group of text
entities in layout space.
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FINDTEXT

This command searches the entire drawing (in modelspace) for a specific text string. If the piece of text that’s searched for is located inside
a long text entry, the whole of the text will belighlighted. For example, if the drawing contains a text entity with the contents :DO NOT
SCALE DIRECTLY FROM THE DRAWING, if the FINDTEXT command is used and the word “DIRECTLY” is used as the search word
(string), then the complete text entity will be highlighted (in a magenta color).

The same applies to an MTEXT entity, the whole MTEXT string is highlighted when the FINDTEXT comamand is used. The same applies
to arc text.

Note that this command will not find text if it is contained inside a block, nor will it operate in layout space.

The SHOWONESPP command found on the gCADPlus drop down menu, is closely related. It can find and highlight those instances of a
specific species in a landscape plan.

gCADPIlus User Guide v2.0
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Introduce variation to symbols

This tool can be used to vary the size and rotation of a group of symbol thereby giving the drawing a more
‘organic’ feel.

A short movie showing how the ‘introduce variation® tool works.

Introduce size and
rotation angle variation
in a group of symbols.
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COPSE command

This command takes a series of overlapping symbols and converts them into a cleaner group symbol (a copse).

This small movie shows the operation of the COPSE tool.

The COPSE command
simplifies groups of
symbols.
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Handling line weights in gCADPIlus drawings

This chapter describes the use of lines of different thickness lineweights in gCADPlus drawings.

The thickness of a line in a printed drawing depends on a number of factors:

The lineweight value applied to a particular gCADPlus entity;

The status of the lineweight (LWT) switch in the drawing editor status line (figure below),
The space that an entity occupies [model space or layout space];

The layer the entity is located on;

Whether or not the entity is contained within a block;

The lineweight setting for the layer; and

The current value for display of lineweights on the screen.

This movie provides an overview of the use of lineweights in the gCADPIlus environment.

gCADPIlus User Guide v2.0

In summary,

- When drafting, leave Format>Lineweight set
at the default value of 0.25mm - 0.01 inch;

- Draft with lineweight set to default in the
Properties box so entities used to make your
design will have the default thickness assigned
automatically;

- At the end of the job, select those entities in
the design that need extra emphasis (like the
building footprint), and set thickness via the
properties box.

- If you need to print on markedly different
sheets (e.g. A4 and A1) move those entities
requiring extra emphasis to a separate layer.
then set the thickness property of the entity to
bylayer and adjust thickness of that layer in the
layers box to cope with different size sheets;

- Adjust the line thicknesses in your title block
such that they work well with your most
common sheet size - A3, ARCH C etc.;

- Do not apply line thickness to a CAD font.
If you need heavy text, use a bold version of a
True Type font;

- Always print a check plot to PDF from the
paper size you will eventually use.

Reach the lineweight settings dialog
box from the Format drop down menu.
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The LWT switch

Line thickness (line weighst) will not show unless the LWT switch is on. A tab on the status line controls the visibility of line weights in a drawing; when active, the
tab is colored red. It is important to be aware of the status of that switch when setting lineweights.

Typical gCADPlus drawing
showing the LWT switch in the
status line (circled).

SMAP | GRID | ORTHO | POLAR | OSNAP || IWT ENT | REGEN ||P
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Why set line weight?

Varying line thicknesses in drawings adds to clarity. The line weight function, gCADPlus gives you the power to create drawings that are easy to interpret and have the
same look and feel as hand drafted plans. In manual drafting, the tradition is to use a series of pens which produce lines of different thickness. For example, the Rotring
series of technical contain varying nib thickness - 0.25mm, 0.35mm, 0.5mm and 0.7mm. Similarly, gCADPIus allows drafters to produce lines of varying thickness.

4 ~
PLANT SCHEDULE
Name

@ Pathlight Plant
& Smal bllet

Brunn: hylla
rae bullet S e e et "

vash Carex testacea 8

ta
Hogen Cador Festigeta

~ %

Voodwardia Fimbriata "
Giont Chain Fom

RN &

4“ % E

%H fﬁf = 1T 1T
; C

*%
-
>k

K.
g

e
'/ DATE:
landscape DescnEoBY.
prosor e

~ Y,

Portion of a partly finished landscape design by Dominion Landscapes. The LWT switch was turned on prior to printing. Right click

and use the marquee zoom tool in Acrobat Reader to zoom right in on the red and cyan lines. Note that these have relatively thick line
weights applied. Note also the construction lines running horizontally and vertically which have very light (thin) line weight applied. The
border has a line weight of 0.005 inches for emphasis. Line weight settings in the title block have not yet been completed.
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Troubleshooting line weights

When drafting with gCADPlus, every entity automatically has a line weight. This is controlled by the value in the line weight field in the properties box. If the line
weight property of an entity has been set BYLAYER, the entity will have its line thickness determined by the line weight setting for the layer. If the line weight
property is set to default, the line will be drawn with the current default thickness setting. That value is controlled via the line weight option in the format drop down
menu shown below.

Some of the many line weight settings available in gCADPlus. Line weight
thickness can be set using either mm or inches.
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The figure below show these two different approaches to setting line weights in the same drawing.

White lines making up the walkway have their line weight property set to BYLAYER. The layer on which the walkway entities have been placed has a line weight
setting of default (0.25mmy), so the lines show as thick. In contrast, the other lines indicating retaining walls and plant symbols have had line weight property set to
0.0 mm in the Propertis Box and show as very thin lines. Implicit entity settings such as this, override layer settings. We recommend using the BYLAYER system to

set lineweight as setting weight implicitly is very time consuming.
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Line weights in title blocks

The figure below show a drawing for a title block prepared for use by a local government authority. The red
line for the border has been assigned a line weight of 0.7 mm (0.010 inches). Other lines in the title block have

been assigned line weights of 0.5, 0.35 and 0.25 mm respectively.
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The figure below shows the very same title block in action on an A1 sheet in a design for a small public park in
a regional area of Australia. The line weight variation set up in the title block are faithfully reproduced.
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Portion of a partly finished landscape drawing for a local government authority. Use the zoom tool in your

PDF viewer to zoom right in on the title block to see that the line weights have been controlled.
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Tip: When printing, be aware of the status of the LWT switch, turning it off will result in a drawing with uniformly thin lines.
Monochrome vs. Color

Black and white (Monochrome) printing is commonly employed for construction teams. Switching to monochrome does not affect the line
weight setting. Variation in line weight will still be seen.

The influence of the default line weight setting

You can set the default line weight style, in the same way that you can set a text style. The default setting is for entities to have a line
weight of 0.25 mm (0.005”). This will likely work well for most drawings. All symbols in the gCADPlus library are drawn with line
weight set to default.

It is recommend leaving this value set at the gCADPlus default. However, to draw a whole series of lines at a particular line thickness it is

suggested that you:
. Create a new layer;
. Set the line weight for that layer to a new value; and
. Draw.

Changes to line thickness for those entities can then be made at any point without the need to edit every individual line entity.
Recommended approach
In summary, the simplest way to work is to:

. Leave Format>Lineweight set at default;

. Leave the lineweight property of entities you use to make your design at BYLAYER;

. In contrast, set lines in your title block with appropriate thicknesses set;

. If you need heavy text, use a bold version of a True Type font;

. Do not try applying line thickness to a CAD font;

. At the end of the job, select lines in the design that need extra emphasis (like the site boundaries and house footprint) and set
thicknesses in the linetype field of the property box; and

. Always print a check plot in PDF from the paper size you will eventually use.
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Managing linetypes

Lines and other entities drawn with different patterns clarity to landscape drawings. For example, in the image below, dotted and dashed
lines are used to prepare a map for a bush walking trail.

Here lines in a map for bush walkers have been assigned different patterns.
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Here the blue line entity has been set to a linetype
that incorporates the characters SW into it and
indicates storm water flow to a minitaure wetland.
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Default settings

By default, whenever a gCADPlus entity is placed into the drawing editor, the entity is assigned the linetype ‘continuous’. This applies
to any entity, not only lines. However, gCADPIlus also allows an entity to have a completely different linetype pattern. For example, in
the figure below, a line representing the front boundary of a site has had a particular linetype pattern called FENCELINE2 applied to it
and the result is a line drawn with circles inside the line at regular intervals. The patterns for linetypes available in a drawing session are
contained in a file with the extension .lin e.g acadiso.lin is loaded as part of the default drawing in the metric version of gCADPlus.

The line representing the boundary
of the site has a linetype pattern
applied.

gCADPlus User Guide v2.0
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Linetype patterns
Linetype patterns assigned to an entity can consist of combinations of dashes, dots, spaces and symbols. As mentioned, these are defined
by a linetype file that is a simple text file with the extension .lin.

Default linetype styles
When you create a new drawing, it already contains linetypes named “ByLayer”, “ByBlock”, and, “Continuous” irrespective of the status
of the .lin file. These styles cannot be removed.

Loading a new linetype file

New linetypes are available by loading a new linetype file via the Linetypes option under the Format drop down menu. As shown in the
figure below, it possible to click on the new icon and browsing to the location of a different .lin file. In this case, a linetype file called
acadiso.lin is about to be selected.

Loading a new linetype

file.

Tip: gCADPlus is compatible with can use any linetype file from the AutoCAD world. These can be downloaded from the net.
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The figure below shows a long list of linetypes that became available once the acadiso.lin file was loaded. Any linetype from that list can
be added to the drawing environment.

Loading additional
linetype patterns.
Tip: For optimum performance, it is recommended that you load only those linetypes you are likely to use. This can be done by setting up
a template drawing with your linetype patterns. These will then be available for new work without having to load them each time.
Tip: The LINETYPE command can also be typed from the keyboard to load a different linetype file.
Tip: It is possible to select and load multiple linetypes from the linetype file by holding the shift or control key when selecting.
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Changing linetype properties of entities in a drawing
Select the entity and change the linetype value in the Properties box.

We use the fenceline2 linetype pattern to show a fence line when working on a design for a narrow space.

The influence of linetype scale on pattern.
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Changing current linetype style
Change the linetype style via the Properties box or by the linetype icon on the toolbar.

By default, the metric version of gCADPlus will load the file acadiso.lin and the Imperial version acad.lin. Both linetype files should be
available to you by browsing to the gCADPlus My Documents folder, no matter which version of gCADPlus you use.

The importance of linetype scale

It may be the case that when you load a new linetype and apply it, the line appears to be drawn with a continuous pattern. This effect
shows in the figure below. Often the pattern will not be seen until you zoom in on the line. In order for the line pattern to show properly,
the linetype scale must be varied. There are no hard and fast rules on what scale is appropriate because the scale will vary according to to
units in use (mm, decimal feet) and the size of the layout sheet.

Adjust the linetype scale of an entity in a landscape CAD drawing for a site in Florida USA.
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Managing layout spaces and printing
Layout tabs are used to present the design as it will appear when printed out onto cut sheets - A2, ARCH C size etc.

The figure below shows a typical landscape design for some community recreational facilities. The design features tennis courts, BBQ areas, children’s play zones
etc. Note the series of tabs lined up across the bottom of the screen just above the command area. These show different aspects of design implemnation - from
instruction about demolition procedures, to the actual landscape plan itself together with details of how to plant particular species etc. These layout views are a
powerful feature of gCADPIus as it is very easy to switch from one layout view to another to show different aspects of the design. All generated from one model.

Typical design in model space showing layout tabs
across the bottom of the screen.
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Clicking on any of these layout tabs switches gCADPIlus to a series of views, each mimicking a paper print of the design. The display is predominantly white with

a grey background. The white background is meant to represent the paper on which the design will be printed and the grey zone, a desktop. In the example shown
below, construction details, including a setout table, are presented on one sheet ready for use by the construction team. Several flaoting viewports are used to present
different aspects of the design. Even though the text here is seen here in yellow, since the sheet will be printed in monochrome text will be black. Other sheets show
hardscape demolition instructions and specialized planting details. These will usually be printed in color. Note that layout spaces will normally contain title block
information - location of site, designer’s name, date, drawing file name etc that is usually placed directly into layout space and not derived from model space.

Survey the use of layout space in a typical landscape design.

Switching to a layout tab shows this view. A legend shows at left and a table of
setout points is seen on the right of the plan.
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Placing entities - Model Space vs Layout Space

In a gCADPIlus drawing file, it is possible to place entities in either:
. Model space or
. Layout space.

Model space is the space where a full size model is constructed by accurately
placing lines, circles and other entities to describe the design. Model space in

a typical job might include site boundaries, building footprint, north indicator,
scale bar as well as the information describing the new design. For simplicity and
clarity, CAD users usually develop landscape designs in model space at full size
(sometimes referred to as full scale). The key factor is that entities reflect the true
(actual) size of structures on the ground. For instance, when drawing a doorway to
a courtyard in CAD, the door would be drawn 3 feet (900 mm) wide, a courtyard
wall might be 6,245 mm (20 ft 6 inches long) - and so on. Any distance enquiry in
model space such as use of the distance command, should give the same answer
as you would get when measuring with a tape on site.

However, since these drawings (models) get placed on sheets of paper that are
much smaller than the actual site, a scale factor is required so that the final
drawing has a usable conversion factor. That’s where layout space comes in.
Layout space is the place where an ‘impression’ of what the design will look like
when printed on a sheet of paper is shown. A typical layout might include a title
block, images and perhaps detail of planting techniques as well as the design
itself.

An example of a typical layout sheet for a design for the front garden of a

house in Florida is shown at right. The design itself is shown inside what is
called a floating viewport. Other elements that illustrate design concepts such as
photographs of species to be used and the designer’s logo are placed directly on
the layout sheets. To reiterate, model space reflects the ‘real world®, while layout
is a paper or presentation space view of the design ready to show the client. As
you will see later, it is possible to apply an accurate scale factor to the floating
viewport containing the design and label it 1/96, 1:100 or 1/8” - 1 foot etc.

gCADPlus User Guide v2.0
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Here images of plant species use in a design for a property in Ft. Lauderdale,
Florida are have been placed on a layout sheet along with suitable images

to illustrate species chosen for the design. These were located in SppDb, the
companion plant database to gCADPlus. Tip: for a closer look at the drawing,
use the magnify tool in your PDF browser to magnify the image.
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Setting up a new layout
To create a new layout space, follow the steps below.

1. Check the size of your design in model space

Before creating a new layout sheet, make sure that a distance enquiry using the
measuring tool gives the expected result. In the example shown, a 5 meter scale
bar has been inserted into the design.

Tip: Including a scale bar in model space is a good idea for a number reasons
apart from providing an internal check.

To do this, use the distance command (selected from the standard toolbar or

the Tools drop down menu) to check the length of the bar. There is always the
possibility that entities have been inadvertently scaled without you being aware
of it. The figure shows that a correct value is given. As time goes by and you
become more confident with CAD and especially where you expect construction
teams to take dimensions from the model, this step becomes less important.

Tip: Scaling a model space drawing up or down is not recommended. Instead,
scale title blocks up and down all you want in layout spaces, but not the drawing
itself. It is only at the final assembly of the drawing on the layout sheet that a
scale factor is considered.

Include a scale bar in model space as an extra check. Here a metric drawing -
scale bar shows 5 meters.

2: Create a layout
Select the Format drop down menu, then choose Create

Layout.
Select layout from Format
drop down menu
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A Page Setup dialog box shown at right (partly obscured) appears. A new layout is
created by selecting the button at top left of the dialog box (circled in the figure).
The desired sheet size can then be selected from the drop down list. Rather than
accept the size of sheet for the attached default printer, it is recommended that you
select a sheet size appropriate for your final plot and scale.

Tip: To identify wrongly placed entities, use the zoom extents option in model
space before using the create layout tool.

Tip: It is recommended that you give each of the layouts a meaningful name. The

first sheet in this example has been labelled Al Sheet 1:100 but Architectural C

size 1/48 is equally good. After a while, you will more than likely dispense with
the sheet name in the title as this can be determined from the Layout Manager.
Names such as front entrance, wetland, deck, demolish, rear garden etc., then
become more the norm.

Click OK and the new layout is created. The view will likely be zoomed in. To
display the entire sheet, right click and select the zoom extent option. The design
itself will be seen inside the border of the layout sheet that is drawn in the current
color (red in the figure below).

Layout created.

A short movie showing how to create a new layout.
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The figure at right shows the floating viewport (selected by clicking on the edge
of the frame) superimposed over the white background of the sheet. In this
example, a portrait layout was chosen and we are about to move the flooating
viewport and center it on the page..

Once selected, the viewport can be sized by moving handles at the corners or
moved by selecting the handle in the middle of the viewport.

Tip: To view additional information when a floating viewport is selected, refer to
the properties box.

Floating viewport
selected by clicking on
the frame edge.

Properties box, no viewport frame selected.

gCADPlus User Guide v2.0
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3. Adjusting the view inside a floating viewport

When a layout is first created, it is likely that the
desired view will not show. To adjust the view of
waht is seen in a floating viewport, there are two
steps:

1. Size and position the actual viewport (in layout
space) on the page to its desired place, then

2. Double click in the middle of the (newly created
and positioned) floating viewport.

gCADPIlus will switch automatically back to model
space. A magenta colored viewport will show on the
background of model space. Size the view using the
handles on corners and move it (using the handle in
the center of the view). Make sure that you cover that
part of the drawing you want to display.

When the correct view is in position, right click and
select “Display on paper space”.

The result is displayed below.

Note the rectangle with the dotted line. This shows
the position of the floating view port on the paper.
One final step is required to set the layout properly.

Right click and select ‘deactivate the viewport*. It
is possible to rotate the magenta viewport frame in
model space, but that’s not recommended.

Tip: If you need to rotate a frame, it is recommended
that this be done before any text is applied, otherwise
the text will also be rotated.
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Layout containing multiple floating
viewports. Frame containing the
design rotated 90 degrees.

Layout view set, but viewport
needs to be deactivated.
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4. Selecting viewports

As you will see later, it can sometimes be difficult to select a viewport when
adjustments to the displayed content or re-position the floating view port on the
paper are required. This is especially the case if the color of the viewport edge has
been set to white as shown in the examples shown at right.

Floating viewport selected - if more than one entity is selected by the crossing
window, deselect by holding the shift key down and left click on the entity to be
removed.

If the viewport is difficult to select because its color
is set white, use the crossing window option to select
a viewport for subsequent adjustment.
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To select a viewport, start a crossing selection box and select the viewport. This
may result in several viewports and other entities being selected. To remove
unwanted items from the selection set, press the shift key in conjunction and slect
with a left click.

Tip: To enlarged or shrink a viewport, drag on the handles.

Tip: It is suggested that you put the floating viewport on a non-printing layer or
change the color of the border to white (255) so it (the border) disappears from
view.

Tip: To copy viewports using the Edit drop down menu, copy a floating viewport

from one layout to another using Edit>Copy>Paste. When doing so, take note of

the coordinates of the bottom left of the viewport in order to paste the viewport
accurately in place on the next sheet.

Tip: The Modify>Align objects tool on the Modify drop down menu can be very
useful here.

Pasting illustrative images into layout space

Pasting images (photographs) of species used in a design into layout space is
common practice. The figure below shows the location of an art installation along
with a photo of the proposed artwork.

This movie shows how to set up a new layout view and position the design
appropriately.

This movie provides a comprehensive overview of the use of layout spaces.

gCADPlus User Guide v2.0
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Copy and paste images

SppDb, a companion plant database application can be used to simplify this
process. If SppDb and gCADPIlus are run concurrently, it is possible to search for
and select an image to illustrate the species. SppDb stores the path to the image
file so it is easy to paste the illustratiion into layout space.

Artwork installation specified for landscape design

This movie shows how to manipulate images in gCADPlus designs.

SppDb is started from the Tools drop down menu.

To insert a copy of the image from SppDb into your drawing use Draw>Raster
Image, switch to SppDb, find the required image and copy the path to the image
into the add file field of the Insert Raster dialog box.

Tip: The image file can be pasted in model space or layout space. Our preference
is to past images directly in layout space using the path to the image file copied
from Sppdb as shown.

Tip: This pasting technique can extend to photos of any hardscape elements you

wish to add.
Copy the path to an image file from SppDb, the companion plant database
application.
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Using the companion plant database application
(SppDb) speeds the selection and insertion of images
to illustrate a design.
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Adding details to a new floating viewport

gCADPlus also lets you add various details to illustrate designs. The example
below shows detail on how to plant an advanced specimen. This information
needs to be displayed in layout space, but in contrast to the photograph of the art
work, it might need to be located in its own floating viewport. This is a must if a
defined scale for the detail is required.

Add a new viewport to an existing layout

The layout manager is used to create a new floating viewport and is activated by

Add a new
viewport from
the layout tab.

Insert tree planting detail in model space. Create a new viewport to
display it on the layout sheet.

right clicking on the tab for the particular layout. The new viewport can be placed
on top of the one containing the design or the viewport containing the existing
design can be moved to accommodate the new viewport.

Tip: It is easier to create the new viewport outside the existing frame as shown
below. Adjusting what is to be displayed in the viewport is much easier. The

_ / _ o o : . Position a new viewport off to the side of the image for ease of
viewport is then moved into position once it is set to show the required view.

manipulation. Move back to position later.
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It is a good idea to put plant schedules in its own floating viewport.

At this stage, the title block information might be added to the layout view. The design is by no means

be complete, but it is a good idea to generate a test PDF print at this stage. The reason is that you need to
confident that the information on various layout sheets is sized correctly, text height appropriate and line
weights and linetype patterns are correctly displayed before doing too much detailed work. If they are not,
return to the model and correct them. Follow the updated settings in any new work. The match properties tool
can be useful here.

Tip: Before printing, make check that the PDF writer is set with the correct paper size and orientation before
printing. Do not rely on a check plot on a small sheet.

A note on printing

It is possible to print from either model space or layout (paper) space. It is recommended that you print from
paper space as the white background simulates the appearance of the final printed sheet.

gCADPlus User Guide v2.0

Display plant schedules
in new viewport

The print dialog box.

1563



Printing a landscape design

Even though it is possible to print from model space, we strongly recommend printing from a layout space so the first step is to swing from model space to layout
space. Then right click the mouse on the layout tab at the bottom of the screen and make sure that the appropriate page size is set via the layout manager. In the
example below, we have chosen an A1 sheet in portrait mode. Once that’s done, check the properties of the floating viewport by selecting it and in particular, look at

the color and scale properties.

If you wish to print to a fixed scale, make sure that property is set to ‘Yes’.

Print a drawing to a fixed scale on an A1 sheet.

it is now time to activate the print command and show the print dialog box
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The dialog box is activated when print is selected from the File drop menu or by typing Control P shortcut, selecting the print icon on the standard toolbar or by typing
the command directly.

The number of options seen here can sometimes overwhelm new users. Here is a short check list.
Check that the current printer is the one you want. In the example below we are printing to CutePDF a PDF writer.

Check that the resolution is appropriate - here 600dpi. The change tab allows this setting to be altered. Note that higher setting will increase the time taken to generate
the plot.

Make sure that the chosen paper size matches the size set in the layout manager.

In the Printing Group, check that Paper is selected. This is the common selection. It is possible to select a Display, Windows or Extents option, but the intention here is
to plot the drawing at a scale of 1:100.

The option ‘Center the print’ is usually ticked.

In the Print scale zone, Fit to paper is selected. Note that this automatically sets a scale 1:.992. That’s close to 1:1 and ceratinly good enough for most purposes if a

If a drawing contains object property overrides instead of ByLayer, you’ll
have plotting problems. For example, you want to plot a general landscape
plan, you would not want to confuse them by showing dimensions, so you
freeze the dimension layer. Oops, only half of the dimensions go away, but so
do several paths, several plant symbols and maybe a set of outdoor furniture.

v gCADPlus User Guide v2.0 155

gCAD*



v

gCAD*

scale bar has been included in the design, but not quite what’s required. In order to print 1:100,
that box needs to be unticked.

Now its is time to preview the print.

Print preview

The figure at right shows the preview box. If the design shows completely inside the red flashing
box, the design is ready to be printed.

The figure below shows what happend when the Display option is chosen rather than page so it is
well worth running the preview option before committing to a print.

Sending the wrong view to a printer is not so much a problem when using a virtual printer such as
CutePDF, but can lead to waste if the print job it sent to a printer attached to the computer.

gCADPlus User Guide v2.0
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Print high resolution on a Mac using gCADPIlus and CrossOver

Mac computers normally handle printing of PDF files from the operating system
level. If you are using gCADPlus on your Mac under CrossOver and want to
generate a reasonable quality PDF use the File > Save as PDF option. If however
you need high quality PDF output, you need to install a PDF writer and print to it.
Although we favor CutePDF as our PDF writer in the Windows environment, we
have not has success with it on our Mac.

The link below from the CrossOver people may help. They suggest that installing
a freeware tool - PDFWriter - may work well and produce high quality PDF inside
gCADPlus. We have been able to make it work and get high quality output as least
as good as CutePDF, but it was a little fiddly to install (see note below).

https://www.codeweavers.com/.../wi.../mac/faq/printfromcrossover

We did have to reset the driver as set out at the end of the page cited above.
and a link to a download page for PDFwriter:
https://sourceforge.net/projects/pdfwriterformac/

You need to use version 1.2.1 of the PDFwriter modified 2011-03-15.

When installing, make sure that you choose the driver-file manually during the
adding process of the printer. You can find it at following path: /Library/Printers/
Lisanet/PDFwriter/pdfwriter.ppd

If the install process has automatically added the printer, delete it and add it again
choosing the driver above. If you allow an automated setup, your PDF files may
contain zero bytes (i.e empty).

Printing to PDF at high resolution from Mac using the virtual printer driver
‘PDF Writer’ under CrossOver. We change the resolution of the printer from 300
dpi to a much higher value of 1200 dpi to increase the quality of the print.

gCADPlus User Guide v2.0

Printed from Mac using CrossOver.
resolutions > 1200 dpi are possible.
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Add an additional viewport to the same layout page

When a new layout is created using the layout tool on the format drop down menu, the new layout automatically contains a floating viewport. That viewport is
drawn in the current color and located on the current layer. You have seen that it is possible to display any part of the design in model space in the floating viewport.
Commonly, that would be the whole of the landscape design.

There are occasions when there is a requirement to show additional views from model space in a signle layout. You might want to keep the plant schedule in its own

viewport. That’s done by right clicking on the layout tab corresponding to the layout you are working on and selecting Add Viewport. The figure below shows this tool
in action in a design for a semi rural site.

This movie shows how to add an extra floating viewport to a layout page that already contains a
viewport.
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Control visibility of layers within a floating viewport

There are occasions where it is advantageous to control the display of layers within floating viewport independently from the state of layers in the drawing as a whole.

This movie shows how to adjust the display of layers withing a floating viewport. We show how a knowledge of this technique can be
used to reduce the amount of work (and duplication) of the design in model space.
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Printing from layout space - metric

As mentioned, for simplicity and clarity, it is suggested that you develop landscape designs in model space at full size (scale) using mm as the base unit. For instance,
when drawing a doorway to a double garage shown below it would be drawn 4810 units (mm), the garage itself 6040 units. However, since these drawings get placed
on sheets of paper that are much smaller, a scale factor is required so that the final drawing has a usable conversion factor.

The first step in the process is via the Format drop down menu, to create a new layout. In the description that follows, we will choose an A3 size sheet as it is the most
common sheet size used by landscape designers. A floating viewport automatically appears on the sheet as the layout is created. The border is drawn in the current
color and on the current layer. The viewport is a ‘window* into the design. The figure below shows the result. There is no fixed scale at this stage - scaling in the

floating viewport is purely arbitrary.

Printing a design - from layout space.
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Printing to a fixed scale - metric

Scaling to a fixed value is often required. This is conveniently done by selecting the “set fixed scale tool”
from the modify drop down menu and (responding to the prompt) pointing to the edge of the floating
viewport.

It is then simply a matter of responding to the prompts in the command line - choosing Metric and then (say)
1:50. This produces a view suitable for presentation of the front space and entrance.

Command Line

Select viewports:
Select a mode of the scale? [Metric or Imperial] <Metric::

Select a available scale value [1:5, 1:10, 1:20, 1:50, 1:100, 1:500, 1:1000, 1:2000] «1:100::
SMWAP | GRID | ORTHO POLAR | OSMAP || LWT  ENT REGEM
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In this example, a value of 1:100 shows the entire site.

Tip: It is a good idea to issue the zoom extents option before selecting “Set fixed scale”.

It is also possible to set the scaling factor by typing a number in the properties box with the floating viewport selected.
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Always run a check plot before going too far

It is a good idea at this point to test how the design might look when printed. We suggest printing to a PDF writer such as CutePDF, selecting the appropriate size
sheet.

Tip: Preview the plot at scale 1=1 (Remember, the actual 1/50 or 1:100 scaling is done inside the floating viewport, but printing is done at 1:1 when an accurate scale
is required.)

It is also possible to select the floating viewport and type a value (50, 100, 200 etc.) in the Properties box directly. Fixed scales are effected by typing a value selected
from the table below into the View Scale field by in the properties box when the layout frame is selected. The set fixed scale option must be set to yes. These steps are
the ones automated by the setfixedscale command.
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Printing from a layout sheet - USA (Imperial) system

For simplicity and clarity, it is suggested that you always develop landscape designs at full size (scale). For instance, when drawing a
doorway in CAD, the door would be 3 feet wide, a courtyard wall might be 20 ft 6 inches long (entered as 20.5 decimal feet). However,
since these drawings get placed on sheets of paper that are much smaller, a scale factor is required such that the final drawing has a usable
conversion factor. These scale factors in the US may be expressed in terms of a relationship between an inch and a foot. Example 1/8” to
1 foot 0 inches; alternatively such a scale is referred to as 1/96.

Imagine a site measuring approximately 200 units (feet) across. If it were plotted onto an ANSI C size sheet (22 inches wide -
approximately 2 feet), a rough calculation would suggest that a scale factor somewhere near 200/2 i.e.1/96 (1/8” to 1 foot) or perhaps
1/64 (3/16” to 1 foot) would be required to show the design on the C sheet.

The first step is via the Format drop down menu, is to create a new layout. We will choose in this case, an ANSI C size sheet - ARCH C
size is also available. A floating viewport automatically appears on the sheet as the layout is created. The border is drawn in the current
color and on the current layer. The viewport is a ‘window* into the design. The figure below shows the result. There is no fixed scale at
this stage - scaling in the floating viewport is purely arbitrary.

ORI CL LIS LR E R LR B

gCADPlus User Guide v2.0

165



Printing to a fixed scale USA

Scaling to a fixed value is required. In gCADPIlus this is conveniently done by selecting the set fixed scale tool from the modify drop down menu and (responding to
the prompt) pointing to the edge of the floating viewport.

Once the Imperial mode for scale is chosen, a series of possible scale factors is presented in the command line and shown in the figure below.. The default value here is
1/32, but we have calculated that 1/96 is a likely candidate, so that new fraction (1/96) is typed. The enter key is pressed to set the new scale.

Tip: It is a good idea to issue the zoom extents option before selecting “Set fixed scale”.

Select viewports:
Select a mode of the scale? [Metric or Impernal] <Metrics: |

Select a available scale value [1/4, 1/8, 1712, 1/24, 1/32, 1/48, 1/64, 1796, 1/128, 17152, 1/384
SNAP | GRID | ORTHO | POLAR | O

LWT | ENT REGEM

gCADPlus User Guide v2.0 166

gCAD*



Y

gCAD*

Check plot

It is a good idea at this point to test how the design might look when printed. To that end, we print to a PDF writer such as CutePDF,
selecting the appropriate C size sheet.

Preview the plot at scale 1=1 (Remember, the actual 1/96 scaling is done inside the floating viewport, but printing is done at 1:1)

It is also possible to select the floating viewport and type a value in the Properties box directly. Fixed scales are effected by typing a value
selected from the table below into the View Scale field by in the properties box when the layout frame is selected. The set fixed scale
option must be set to yes. These steps are the ones automated by the setfixedscale command.

The following table shows the values to be typed in the scale field of the properties box to achieve desired Imperial scales. The values in
the column at left enable a conversion from a drawing in decimal feet to a plot on a metric piece of paper (1 foot is close to 300 mm [exact

A value of 0.32 is automatically fed to the scale field in the
Properties box (see later) when the scale 1/96 is typed.

gCADPlus User Guide v2.0
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304.8) e.g. 192/300 = 64

Value to type in Required scale 1/X USA notation
Properties box

0.04 1/12 1:to 1 foot
0.08 1/24 1/2" to 1 foot
0.16 1/48 1/4" to 1 foot
0.32 1/96 1/8" to 1 foot
0.64 1/192 1/16" to 1 foot

Tip: The data in the box above was taken from an Excel spreadsheet and rounded for convenience.

Now is a good time to return to model space and add to the design. For example, you might want to add explanatory text, shadowing,
paving details etc. You can do this with confidence because when the final plot from layout space is generated, an accurate scale factor can

be placed on the sheet.

Tip: The value Scale 1:96 can be placed in model space or on the layout sheet, possibly in the title block.

Adding images to layout spaces

Our plant database application can be used on top of gCADPIlus and used to search for images to illustrate the characteristics of plant

species in a design.

This movie surveys the use of plant databases while designing.

gCADPlus User Guide v2.0
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Handling line thickness (lineweight)

The images of the design shown above were developed
without turning display of line weights (lineweight)
on. Most professional landscape design drafters would
prefer to apply line weights to their drawing, because
doing so makes for clarity. gCADPlus features a line
weight display tool. Clicking the LWT button turn

the display of lineweight on. The images here shows
the sample drawing with display of lineweights

turned on and off. Note the marked difference in the
appearance of some symbols. Symbols can be edited
and lineweight values altered if required.

gCADPlus User Guide v2.0

Lineweight display off above.

Lineweight display on.
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Setting lineweights in working drawings

There is a complex interaction between the lineweight value applied to a particular entity, the layer that an
entity is located on, whether or not an entity is a block (and the layers within the block, the lineweight setting
for the layer and the current value for display of lineweight.
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Set lineweights
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To illustrate, the image below shows this same design where lineweight display of all layers in the drawing is
set to default (this is the layer lineweight arrangement in place when you start a new gCAD+ drawing). This is
probably the easiest way for beginners to control lineweight.

How dark the image will appear on screen is dependent on the setting under Format>Lineweight
If the default for lineweight display is set to 0.00 (thinnest line) the design will be lightly drawn as shown
below.
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Display setting zero, all entities
lightly drawn.

Controlling lineweights
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If the general display of lines in the drawing is not dark enough for your liking, it is a simple matter to change
the thickness of lines by changing the display default value.

In the figure below, we have changed the lineweight to 0.016 inch as we are working in a USA drawing. All
lines are much darker. It is a simple matter to experiment with this display value until the desired effect is
obtained.

Display setting 1/16” - linework
emphasized.
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It is a good idea to run a quick check plot to PDF to ensure the display value meets your desired standard.
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Display setting 1/16” - line work emphasized - check PDF
print. A little too dark perhaps.
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A value somewhere between 0.000 inch and 0.016 inch should give a reasonable compromise between enough definition for line work without any bleeding of symbol
detail. The figure below shows the result with a value of 0.06 inch for default lineweight.

Plant Botanical Name Total
Acer circinatum 3
vie ogle
Brunnera macrophylla o
. Sberion bugloss “dack Frost’
Carex testaces B
. Prae P Sedge
Choisya temata ;
exican orange ‘Sundance’
[ | o ;
Daptine 'Carol Nackie
. Heuchera x ‘Marmalade’ 3
Vormlade Cord Bells
. Leucothoe Fontanesiana 5
Laucotros Nona
Lirope Muscarl
[ | o, x
Ophiopogon planiscapus 3
Block ondo rass Nirescens’
Ribes Sanguineum King Edward VI’ 3
King Edwcrd Flowering Current
Sorcococcs B
Frogront Sweet Box
Thuja PI
Hogan et 3
. R ] Woodwardia Fimbriata "
ciont Chan Fem
e
[
L% %
‘
R Ll
e
q & Q A S AL
.
N 1)
.
e
.
FILE:
= oATE
Joncheape DESINED BY:
PROJECT: SCALE:

N gCADPlus User Guide v2.0 174

gCAD*



Varying lineweight in individual entities
The above description focused on applying general line thicknesses. However, a drawing can be given much more ‘life’ if attention is paid to setting line thicknesses
on individual entities.
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Specific lineweight applied to the lines indicating the footprint
of the house.

Tip: Paying attention to lineweight is especially important where the border and title blocks are concerned. The figure below shows that if the border and the lines
representing the house footprint have been assigned a heavier line weight, the ‘readabliity’ of the drawing improves.

Note that even though lineweight display is on, the plant symbols are lightly drawn.

Tip: Line weight can also be controlled by layer settings. In our view it is important to have a clear idea how line weights are being controlled in a particular design. .

It can be tricky to manage this process of adjusting lineweights unless you have a clear understanding of the behavior of layers and lineweight settings inside block
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entities.

The value of controlling line weight is very apparent in this sheet showing a cross section through the water feature. The dimension lines are drawn with a finer line
weight than the water feature itself.
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Printing designs where transparency has been applied to entity color

If color transparency has been applied, it can be challenging to print the design to get a satisfactory output.

This movie shows everything you ever needed to know about printing landscape drawings where the drawing contains entities with color
transparency applied. In the movie, we show how to print to BullZip, a traditional PDF writer for high resolution output and compare the
output to that generated by the inbuilt gCADPIus ‘Save As PDF’ tool.
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Text in gCADPIlus drawings

Text entities in gCADPlus drawings are created using different font types. These fonts can be true CAD fonts such gCADPIlus fonts, AutoCAD SHX fonts or
Windows fonts. The actual text entity is created using the TEXT, MTEXT or WTEXT command and is drawn in a style dictated by the current text style. Several text
styles are built into gCADPIlus and are called standard, simplex, comlex and mono. These styles cannot be removed.

It is possible to create new styles using a font chosen from quite a long list. The figure below shows the gCADPIlus TextStyles Manager and the CAD font simplex
currently associated with a style called Stylel. A Windows font Garamond also appears in the list its distinctive blue and black TT icon. The green tick shows the text
style (standard in this case) that’s currently in operation - the default.
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Creating a new text style

Styles are created via Format > Text Styles > Text Style Manager and selecting New. The figure above shows that a style called Stylel has been created and it uses
the font Simplex. This is a CAD font and a sample of text drawn with that font is shown in the Preview box of the Text Styles Manager. Notice that Style2 uses a
Windows TrueType font called Garamond. So in this example, one style uses a CAD font and the other a Windows font. Note the different icon associated each font.

Tip: Where possible, it is best to use CAD fonts as these enable the text to be drawn with precision irrespective of the magnification factor. Magnifying Windows fonts
sometimes results in blurry text.

This movie shows how to manage text in a drawing.

This movie provides another view of the use of text in landscape designs. The figure below shows an example of the use of a handlettered CAD font.
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Hand lettering styles

There are a number of hand lettering CAD text fonts available in gCADPlus that can be used to give some flair and personality to your designs. Finding a style that
suits your drawing style and incorporating it into your gCADPIlus template drawings such that it is always available, will help to create your ‘signature’ look and feel.
The figure below show some examples of the use of computer hand lettering CAD based styles.

In addition to those CAD hand fonts provided with gCADPlus, many more TrueType Windows fonts are freely available on the Internet. Once installed into the
Windows fonts folder, gCADPlus will allow any Windows font to be used as a text style. You may need to re-start gCADPlus after a new Windows font has been
installed.
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Use of text use in drawings

Text conveys important information in landscape drawings. It is used to label symbols representing plant species, in dimensioning styles, in title blocks and to add
specification notes or to make other annotations.

Single line text, multi line text, Windows True Type text and
arc text are all used in this drawing. Some lettering styles
here use CAD fonts, others use Windows fonts.
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Types of text objects

To reiterate, text can be applied in a number of different entities:

. Single line text;
. Multi line text;
. Arc text; and

. Windows TrueType text

Single-line text showing insertion point and rotation handle. The properties box
enables changes to be made to alignment - left, right, center justified etc.

Select single line text from the draw drop menu,
draw toolbar or type the T shortcut.
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Single line text

Single-line text is an individual line of text contained in one text object (entity). It is useful for labels and short notes. Most gCADPlus drafters will use single-line text
as their main text entity in a drawing. It is important to keep in mind that text is placed using the current text style (see later).

Tip: The text style chosen (and the accompanying font) has a major influence on the display. Different fonts will show different height, even when the height setting is
the same.

The use of upper case is easier for construction teams to read plans. It is also
possible to use a font that s all uppercase for this purpose.
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Placing text
The single-line text command can be selected (started) from the Draw drop down menu, the Draw toolbar, by typing TEXT or the T shortcut in the command area.

When you create text, end each line of text by pressing the enter key. The insertion point of a single line text object is a point object indicating the coordinate location
for placing the text. The text height is a real number defining the height of the upper-case characters in drawing units.

The usual sequence of prompts are as follows:

Specify the insertion point for the first character;

Specify the height of the text;

Specify the text rotation angle;

Type the text, and then press Enter at the end of each new line; and

Press enter again to complete the command.
Tip: If you have previously placed a line of text try hitting the ENTER key when asked for the height and angle of text. The height and angle will remain the same as
they were in the previous entry.

Aligning text
If you have several lines of text drawn as single objects, use the align text tool in the Modify drop down menu to justify (line up) the text. Note that text objects can be
justified left, right or bottom.

Here the align text tool
is used to right justify
a series of text objects
that were originally
arranged as show on
the left of screen.
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We encourage the use of upper case text where possible as its easier to read on a paper plan when on site.
A construction team often works under difficult circumstances - paper prints of drawings get smudged, dirty, wet and suffer a lot in the build phase. Therefore, it is
recommended that you use upper case annotations and notes where possible as they are much easier to read .

Paragraph text (MTEXT)
If you have notes that exceed several lines, use ‘paragraph text’ tool. Paragraph text consists of one or more lines of text or paragraphs that fit within a specified
boundary. Each paragraph text entity you create is treated as a single entity, regardless of the number of individual paragraphs or lines of text it contains.

Here the text under the heading NOTES is applied with the MTEXT command.

To create paragraph text, first determine the paragraph’s boundary width by specifying the opposite corners of a rectangle. The text automatically wraps so that it fits
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within this rectangle. The first corner of the rectangle determines the default attachment point of the paragraph text. You can change the location of the attachment
point in reference to the rectangle, and you can also determine the direction in which text flows within the rectangle. It is also possible to select the text and paragraph
format, text style, text height, and the rotation angle of the entire paragraph text entity.

10 add a bullet to an MTEXT type the following code in front of the text string: {\symbol|b0]i0|c2|p18;- }.

These rather obscure control codes are used by AutoCAD. gCADPlus users commonly interact with drafters who use AutoCAD - Surveyors, architects and civil
engineers and we maintain compatibility in this way. At some future date, we hope to have developed an MTEXT editor that allows seamless insertion of the codes.

MTEXT spacing

A block of MTEXT is a gCADPIus object and it is possible to change such things as line spacing and rotation using settings in the properties box associated with the
entity.

Alter the size of the MTEXT box by dragging the
handles.
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Arc text

This option allows text to be set around an arc or circle. It is commonly used in the creation of logos. The command starts by ‘throwing up’ the arc text dialog box,
type in the desired text and set desired options for the placement of the text. The current text style must be created witha Windows font for this to work.
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True Type Text

This option has been provided in order to allow any Windows True Type font to be used in a drawing. Provided that the font is installed in the Windows fonts folder,
then a text style can be associated with that font can be used

We see this option being used whenever there is a particular need to match an uncommon font. This often occurs where a landscape practice has an existing logo that
uses an unusual True Type font. The WTEXT command enables font matching.
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Reuvisiting text styles

gCADPIlus allows you to define one or more text styles, each with a name and particular attributes (e.g. spacing, size etc.). A text style can be created using CAD or
Windows fonts already installed in your computer or from True Type fonts downloaded from the Internet.

Tip: It is recommended that a restricted set of styles be used as using a multitude of fonts in a drawing can detract from the presentation. Try and settle on a single

text style, making sure that the one style (using a hand written Windows font) becomes our ‘signature’style for labeling your drawings.

A note on fonts available in the gCADPIlus environment

It is important to understand that a number of different font types are available for placing text into a drawing, whether the text being applied is single-line, multi-line,
arc or Windows True Type text.

The figure below shows some embedded fonts at the top of the list (these are part of gCADPlus and can never be removed - they remain available even if the
gCADPIlus fonts folder is deleted). The remainder of fonts shown in the figure (the fonts with the divider icon alongside) are gCADPlus CAD fonts. These latter fonts
are loaded from the gCADPlus fonts folder when gCADPIlus loads.

If you scroll further down the list, a series of Windows True Type fonts will show.

Don’t forget it is possible to create a text style using an embedded font, a CAD font or a Windows True Type font.
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Hand lettered fonts

Most landscape designers prefer to use a font that mimics the type of lettering they already use in their hand drawn plans. The figure shows some hand lettered CAD
fonts being used in a gCADPIlus drawing. We purchased several shown below from a supplier on the Internet.

Creating a text style

It is recommended that gCADPlus users develop (and set as the default in their own template drawing), their own particular lettering style by creating a named style
with a selected a Windows font.

Here are the steps to take when creating a new text style:

. From the Format drop down menu>Text Styles>Select New Style;

. Text style new;

. Type the name of style, select the font to be used and nominate the height.;

Tip: When you have made a new style, make sure that it is set at current.
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Test possible fonts

The figures here show some different Windows fonts tested by one designer before settling on a style that gave the desired ‘look and feel’. Testing was done by
making a plant schedule with a named style, and then redefining the style using a number of different (free) Windows hand lettered fonts downloaded from the net.
The plant schedule was printed to PDF after each test and the results shown below. The name of the font is printed under each plant schedule.

Tip: It is important to do this print testing as some fonts give a much better print result than others. There is also a big difference in spacing.

Pre loaded styles and templates

A number of styles are pre-loaded in some of the
templates and you can access them by the Text Styles
link on the Format menu. However, it is recommended that
you to use this tool to define your own text styles in your own
templates
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The gCADPIlus menu

Many tedious landscape drafting tasks have been automated in gCADPIlus. These are gathered together in a drop down menu. The figure below shows this menu and
some of the tools reached from it. Note that many of the options such as the Plant Schedule have associated fly-out sub-menus.

The gCADPlus drop down menu.
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In this chapter, we discuss the operation of the various tools on the menu including:

. Labeling of plant symbols in designs for small scale sites and in large, broad scale, landscape projects;
. Generating and updating plant schedules;

. Generating broad scale plant schedules;

. Extracting block information and passing data to Excel and costing designs;

. Tagging and calculating ground cover planting;

. Extracting plant and ground cover schedule information to Excel;

. Importing data from GPS equipment;

. Storing, propagating and extracting extended data with entities;
. Moving data to a layer for importation to SketchUp;

. Writing SketchUp information to DXF;

. Applying shadows to plant and other symbols;

. Filling closed polylines with symbols;

. Copying symbols along a line;

. Using plant palettes;

. The COPSE command,;

. Setting a URL with a text entity;

. Writing block data to a file; and

. Using gCADPIlus GIS facilities.

. The GOTOSPP command - bidirections data movement between gCADPlus and SppDb

Tip: A number of tools on this menu are dealt with more fully in Chapter 3 - ‘Draw with gCADPlus’
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Labeling plant symbols

Landscape designers use a variety of methods to indicate (label) the particular plant species associated with a given landscape symbol.

Text

The simplest approach is to label a symbol with a piece of text. The text can be placed in the middle of the symbol or a line/leader can be used to indicate the species
as show in the figure below. Four examples of different symbol labeling using leaders with text are shown below. The first shows only text (RS) centered in the middle
of the symbol, the next symbol uses a leader with no arrow, the third a leader with arrow and the fourth a leader with a custom arrow.

Text labeling. Many
different leader styles
are possible

This movie shows some different labelling methods being applied to symbols in a drawing. Note that the current dimensioning style must be set to the style of

lettering you require.
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https://youtu.be/9BkeU0j-4uE

Required steps:
Create a new symbol or insert one from the gCADPIlus library.

Start the single line text command and type the code or name. Place the text. If required, move the text to a suitable position.

Alternatively, use Dimension > Select Dimension Style > Make the style current and use a custom leader to label the symbol.

Note that there is no automation in this approach. The text codes used in the design need to be typed later into a table - perhaps adding a code, botanical name,
common name and number to form (create) a schedule as shown below. This is a relatively time consuming method an is open to errors. As shown in the figure below,
text may not line up, consistent botanical and common names are not always achieved. If new copies of additional symbols are added later, the count needs to be
repeated. A far better approach will be discussed later - use a tool in gCADPlus to automatically generate thea plant schedule.
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Use colored circle & text

Some designers will use a restricted set of symbols - perhaps no more than 10 - and use those symbols again and again. By placing a numbered circle on top of each
symbol and creating a table of numbers linking to a species, a labelling system is generated.

Again, the codes used are typed into a table along with the botanical and species names of the plants to form a planting schedule. This sytem can work reasonably well
on small designs, especially where massed planting of single species is used.

Here a piece of text inside a red circle is used to key each symbol to a particular species. Although here each and every symbol is marked
with a number, where similar symbols are grouped, (e.g. 5, 6 in this example), it is not necessary to tag each individual symbols.
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Automating the generation of plant schedules and lists

gCADPIlus offers a set of tools to automate the production of a plant schedule. We have tried to make the process flexible and some examples of different styles of plant
schedules geberated by the PLANTSCHD command are shown in the figures below.

This movie provides an overview of the steps involved when using gCADPlus to automatically create a plant schedule (list).

Examples of plant schedules produced using the
automated gCADPlus system.
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Here is another overview of the steps involved in automating the process of generating a plant schedule.

Here is a similar movie, this time a custom plant schedule is generated.

Selecting the plant schedule option

To generate a schedule, select the first option on the gCADPIlus drop down menu - “Plant Schedules and Lists”. Once selected, a series of sub-options are presented.
Each is used in different way to mange the process of making a plant schedule and keeping it up-to-date.

Selecting the main plant
schedule option.

Step 1. Attaching a plant list (.gcp file)
Every landscape designer creates specific species lists for their various projects. Species from the list are chosen for their ability to grow well at the site in question
and possess features that will enhance the design. Lists are usually drawn from personal experience gained over many years and are part of a landscape designer’s
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intellectual property. Designers keep lists in many different forms - from list on paper to sophisticated online databases. gCADPlus allows designers to attach an
electronic list with each CAD drawing. These lists can act as a plant data file and assist greatly in plant selection and can be used over many different drawings if
required. The first step in generating a plant schedule is to attach a plant database file to the drawing.

The figure below shows a design with the attached plant list displayed.

These plant data file are simple text lists and have the extension .gcp. The list can be short list suited to one site only, or a much longer list containing all the
designer’s favorite plant species.

The first step in making a schedule is to attach a list.

v gCADPlus User Guide v2.0 501

gCAD



Tip: A sample list called GardenCAD.gcp is provided with with gCADPlus and stored in the My documents>gCADPlus folder.

Tip: We have placed some lists on the download page of this web site, but we really encourage you to make your own lists and customize the list environment to suit
the way in which you work.

Tip: It is important to be aware that many of the automated tools including plant scheduling in gCADPlus are dependent upon a suitable plant list (.gcp file) being
attached to the drawing.

Spellcheck inside a plant list
The figure below shows another example of a drawing with a gcp file attached. Note the red underlining in species names in the list indicating potential mis-spelling.

Plant list for a garden in
Paris.

Here is a small movie showing how to remove the red underlining and make spelling corrections in a plant
database file.
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If gCADPlus sees a word in your plant list that it does not hold in its dictionary (or suspects that it is mis-spelled), the word is highlighted in red. To add the word,
simply hover over the underlined word, right click with the mouse and select ‘add word’.

Tip: If you have chosen a word with special characters like quote marks, remove those before adding the word to the dictionary.

Plant list for housing
sub-development.

Here is a small movie showing how to attach a list how to work with a plant database list suitable for a
mediterranean climate. Adding new botanical words to the gCADPlus dictionary, correcting mistakes and
sorting the list are demonstrated.

Tip: Any number of additional columns can be added to the plant list.

Adding species name to
dictionary.

We cannot over emphasize the value of learning to use the plant list effectively. Some designers have comprehensive lists of several hundred species with information
on text code, pot size, flowering time, flower color landscape use etc. That enables them (with the aid of the sort facility) to find a species for a particular use in a

landscape plan.
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Step 2: set data to a plant symbol

In order for the automated plant schedule tool to work, once the plant database file is loaded, each unique symbol in the drawing needs to be tagged with the
appropriate species name (record) in the accompanying database file. The steps are:

Select the gCADPlus drop menu, then Plant Schedules and Lists and finally “Set data to plant”. This command and promts for selection of a particular symbol. Right
click to finish the tag. If you select the same symbol agin (with out activating the ADDPLANTDATA command, its botanical name, common name and code are shown
in the gCADPIlus properties box.

Tip Once a symbol has been tagged, there is no need to tag other copies of that same symbol.
How to assign a species name in a gCADPlus plant database file to a plant symbol. Tip: If you have a copy of our personal plant database

tool - SppDb, it is possible to write out (save) a .gcp file from that application.
Using the species find facility

You may need to find a species from a long list. This ovies hsows how the Ffind tool when assigning a plant species to a symbol.

Step 3: Remove a tag

It is often necessary to remove a tag. For example when substituting one species for another.

Tip: Once attached, the path to the attached database file is shown in the status line at the bottom of the drawing.

Creating new plant data files

Plant data files used to make plant schedules in gCADPlus have the extension .gcp. They can be created from scratch within the gCADPIus environment using Tools
> Create .gcp file or by loading an existing .gcp file (a sample file is delivered with gCADPIus and select New.

Set data to a plant symbol

Associating a species name with a symbol used in the design is the next step. Use the ‘Set data to plant’ option on the gCADPlus drop down menu. This option calls
the ADDPLANTDATA command with a prompt to select the symbol and the appropriate row in the gep file. Use the right click to exit when enough symbols have

been assigned to species.

Removing data from plant symbol
This option is used to break the association between a row in the attached plant data file and a symbol. The symbol needs to be selected before running the command.

If you have made an error in a gep file — say in the spelling of a plant name — and correct it, it is necessary to break the connection between a symbol and the record in
the plant schedule. Then reassign the symbol to the newly corrected plant name.

View a plant list
Use the plant list option for a quick look (on the screen) at the currently assigned species list.

Show symbols with names
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Show SppTag

Use to make an enquiry of a symbol. The option reports the Botanical Name, Common Name, and code in the Command line as shown in the figure below. Data also
shows in the zone at the base of the Properties Window.

It may be necessary to
increase the height of
the Command Window
in order to see species
details.

If a tagged symbol is
selected, its botanical
name, common name
and tag are shown in the
Properties window.

v gCADPlus User Guide v2.0 005



This movie shows how to tag symbols in a design for a rear garden site in suburban Paris.

This option is used to show all plant symbols that have had names assigned and is used to make sure that no symbols have been missed.

TBypical standard schedule. The symbol, botanical
name, common name and total number of each species
is listed.
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Work with a plant list from a site in Florida. We assign an new symbol to the
Here is a small movie showing how to attach a plant list, tag plants, apply line
weights and lay out a design for a front entrance to a house in Florida, USA - on
a size C sheet.

Search for symbol

This option is used to find an association in the design. Enter whole or part of
Botanical Name, Common Name or Code.

Draw the plant schedule

Once all symbols used in a design have been tagged with a plant name from the
plant list, it is time to draw the schedule. Two sub-options under “Plant schedule”
are available - a standard or custom schedule.

Draw standard schedule

This option draws a standard version of the schedule, drawing a column containing
the plant symbol, a column for botanical name, a column for common name and
the total of each species in the last column.

Draw schedule - custom content

This option allows control over the columns in the plant schedule. Instead of
drawing the schedule immediately, a number of questions are asked:

1. Include plant (species) symbol? [Yes/No]

2. Include red circle markers?

Tip: It is then possible to copy the number with white text on a red circle and
place it over groups of plants of that species. This is especially useful where
massed planting is used.

3. Include code? This is the text code contained in the gcp file (plant database)
currently attached to the drawing.

4. Botanical name?
5. Common name?

6. Print botanical name under common name?

Tip: Choosing this option can make the schedule more compact.

The exact number of each species in the design is totaled as the schedule is drawn.

gCADPIlus User Guide v2.0
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Plant schedule variations

PLANT SCHEDULE
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Tip: There is no need to remove the current schedule if a new one is drawn. That will happen automatically. Note that the schedule/table is drawn in the current text

style.

The schedule is drawn as a block and can be scaled or moved around the drawing as a single entity. It is also possible to edit the schedule block.
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Tip: If the columns are too wide, simply draw the schedule again using a narrower pair of pick points.
Update a plant schedule

Use this tool to update the schedule taking into account any changes you may have made to the design since the schedule was drawn. Changes may involve removal or
addition of symbols as a design is refined. The schedule is drawn again in the original position, updating the numbers as it does so.

Generate a plant schedule for a site in Massachusets, USA

&%

S® I He B0 5He

o

B O ()| @i

s

@B |

CLIENT RESDENCE
VAESEE COGET U

% Mahoney's -

" gCADPlus User Guide v2.0 210




Search for a symbol

This option is used to identify a particular species in a design. There are times, especially when working on a design for an extended period when it becomes difficult
to remember the particular symbol assigned to a given species. This tool enables searching on either botanical name, common name or code.

The tool might well be used if a species previously specified in a design needs to be substituted with another; perhaps because it is unavailable.

This short movie shows the tool in action.

Search symbol

There are times when it is useful to show the name and details of a species
associated with a symbol.

This movie shows the Search Symbol tool in action

Command Ling

Bptanical Mame - Abslia grandiflora
Commaon Mame - Glossy abalia

Coda: Ag

Selact he symbal to show data information

Caommand
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Smart label tool

This tool is part of the Plant Schedules and Lists group - the first item on the gCADPlus drop down menu. It is designed to complement other tools for identifying plant
symbols in a design. It provides considerable flexibility in the way in which a symbol represent a particular species is labelled and can be used in conjunction with the
automated plant schedule tools.

This movie shows how the SmartLabel tool works.

Smart label tool - picks up
information from the gcp file
attached to the design and labels the
symbol using data from the file.

The command when started, first prompts for a selection of a single symbol (or group of symbols of the same type).

Tip: The symbol must already have been assigned to a record in an attached gcp file otherwise the command will fail.

After selection, hit ENTER. The next prompts asks for a start point for a tag line [the tag line is attracted to the insertion point of the symbol, but the location can be
anywhere you like.] The hit ENTER.

Then the next point(s) on the tag line can be indicated. Hit ENTER when finished locating the line.
Next define the text height. Hit ENTER when set.

The next step is to nominate the type of labelling. The options are:
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1. Include the total number of plant symbols in the selected group.
2. Include the species code as the label.

3. Set the botanical name as the label.

4. Set the common name as the label.

The figure below shows some of the variation in labelling that can be created using this tool.

Smart label tool -
different options
produce a variety of
labels.
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Broad scale planting

Landscape architects when working with large areas, often use the same symbol over and over again to represent different species. As shown in the figure below, it is

common practice to link each plant with a line drawn from the insertion point of each symbol to the next. with the number of plants in the group totalled as a prefix to
a text code indicating the botanical name of the intended species.
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Linking symbols, totalling the number in the group
and adding a code.

This can be a tedious process and gCADPlus provides a mechanism for automating this type of broad scale plant labelling.
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If a project requires plant labeling in this manner, choose the broad scale planting option from the gCADPlus
menu.

This movie shows how to use the LINKLABEL and LINKTABLE commands in the gCADPlus
environment. It demonstrates one approach used by landscape architects when working on large scale plans.
Broadscale tagging an labelling steps
Follow these steps:

. Choose gCADPIlus>BroadScale>Attach list.
. Next select BroadScale Planting>Label groups of symbols with code.

As shown in the movie, this command asks users to first select a species (row) from the gcp file. Once that’s
done, the type of labelling needs to be selected (M)ultiple or (S)ingle. Single symbols can be labelled or more
usually, a group of symbols can be labelled terminating with a count of the total number of plants in the group
and a species code. After the type of labelling has been chosen, the first symbol in the group is selected with
the left mouse button, then the next and subsequent symbols. A line is drawn from the mid of each symbol to
the next.

When the last symbol in the group has been selected, hit the ENTER key. The next prompt asks for a location
for the label.

Then the desired height of text is indicated. A value for text height can be entered or alternatively, simply

Use SppDb t t lant data fil CADPlus.
move the pointer away from the end of the label line and click to indicate a desired text height. se SppDb to create a plant data file for g -

The command concludes by writing the count of the number of plants in the group followed by a dot (period)
and the code taken from the gcp file.

Building a broad scale plant list

The option “Print schedule of linked plants draws the broad scale schedule in much the same manner as the
plant schedules and lists tool does.

Creating a gcp file

The broad scale plant tagging tools are used in conjunction with a plant data file (.gcp). As discussed earlier,
a plant data file (gcp file) can be created ‘de novo’, but it is much easier to generate the plant data file by
exporting one from the companion plant database application SppDb.

This plant database application enables users to storage and filtering of plant species and subsequent export of
a gep file. Once that is done, broad scale tagging of plant symbols in gCADPlus can begin.

Note that the Botanical name, Common Name and Code are passed to the .gcp file. These three fields are used
in tagging symbols and in creating a broadscale plant schedule list.

Linking and labelling symbols.
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The figure below shows a demonstration of the use of the BroadScale labeling tool. Symbols have been chosen from the BroadScale group in the symbol
library. The same symbol is used a number of times and represents different species. the symbols have been tagged with a polyline, counted and labelled
automatically. The broadscale plant schedule tool is then used to draw the schedule. Note that several clumps of symbols representing the same species
are automatically totalled in the table.
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Extract block data

This fly-out item option on the gCADPIlus drop down menu’ enables the extraction of block data in the drawing (or part of a drawing) to a CSV file. A CSV file is a
simple text file that can be used by many different software applications including spreadsheets like Microsoft Excel and Databases like Microsoft Access and SQL,

FileMaker Pro etc. Several different options are provided.

Extract all blocks
Every block in the drawing is listed in the extract file, along with its x and y coordinate, the layer and any value that happens to be present in the key field.

Here is a small movie showing the use of the extract all block option.

Export a block list.
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The resultant CSV file

The figure below shows an example of an extract file displayed in the Windows Notepad editor.

The figure at right, shows a sample from a different design file, imported to MS Excel. Every block in the drawing is listed, along with its x
and y coordinate, the layer and any value present in key field.

CSV information now in Excel.

CSV file in NotePad.
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Block list

Given a modest level of Excel skill, it is possible to use macros and pivot tables to
process this information for quotations and bills of materials.

Key information

Note that GCADPIlus allows keys to be attached to any entity. As can be seen from
the figure, the extract blocks routine also extracts the key value.

Extract blocks, irrigation

The Extract tool on the gCADPlus menu can be used to extract all block
information from a gCADPIlus drawing. If that information is passed to Excel, the
filter tools and the COUNTA function in Excel can be used to total up the number
of individual blocks.

Here is a small movie showing how to extract details of materials needed for an
irrigation design. In this example, we add sprinklers, gate valves, elbows end
plugs, T-Junctions etc from an irrigation layer. Extract irrigation data.

The data is passed to Excel and the COUNTA function to total the entries in each
category.

Extract blocks - lighting

We use the Extract blocks for layer tool to produce a list of lights used in a
landscape plan ready for importation into Excel.

Irrigation data in Excel.
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Extract all blocks from an area
This option is used when it becomes necessary to extract block information from a restricted area in a design. For example, there may well be a requirement to extract

all block information from the front or rear yard of a site.

Extract blocks by layer
Helpful if it is necessary to extract information for specific purposes.

Here a short movie showing how block information on paving stones can be efficiently extracted.
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Ground cover planting

There are many different ways to indicate ground cover planting. Landscape designers will often draw a closed polyline to indicate an area to be planted to a ground
cover species and hatch it as shown in the example below.

One convention for indicating large
scale ground cover planting.

Taking into account the area to be planted, they would then calculate the number of plants of the particular ground cover species required to fill the area, taking into
account spacing. In the example above, 90.DC is the convention used. The designer calculates that 90 Danthonia caespitosa (Wallaby Grass) specimens will fill the
cross hatched area.
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Ground cover planting

Effective ground cover planting takes many forms. Many different spcies can be used.
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At other times, especially where small areas and close planting is required, the area enclosed by the polyline is left unhatched as shown below. Nine specimens of
Dichondra repens (Kidney Weed) are required to fill this rather small area.

These marking and tagging calculations can be automated in gCADPlus.

Alternative notation for ground cover
planting.
The drop down menu has three options.

One tool (Make ground cover) asks for selection of the polyline defining the area, the routine then ‘locks’ a particular ground cover species to the space by calling up
the plant database file currently attached to the drawing, calculates the number required and applies the label, leaving a marker code indicating the area to be planted.
The second tool is used to show those areas that have been tagged, The final other tool generates a schedule of ground cover planting.

This movie shows the ground cover tool in operation.

Option 1: Make ground cover
The figure at right shows the ground cover group of tools in the gCADPlus drop down menu.
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The first option asks a user to point to the closed polyline. This results in the appearance of a small multi-entry dialog box (shown at left
in the figure below) requires information about the units of measurement for an area - square mm, meters or feet and the spacing distance,
the species name (selected from the gCADPIlus plant list), that populates the dialog box with a short text code to indicate the species to
be used. Once the data has been entered, gCADPlus calculates the number of plants required and starts the leader command, enabling
tagging the area with the appropriate information. In the example shown below, 63 plants of Danthonia caespitosa at a spacing of 1250
mm were required to fill the area.

The process begins by starting the sequence described above and concludes by placing a small marker in the area to indicate the number

gCADPIlus User Guide v2.0

Ground
cover
calculation
dialog box.
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of the ground cover zone. This marker is used in the generation of a ground cover plant schedule.

63 specimens required.

Ground cover marker.
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Draw ground cover
schedule.

Option 2: Show tagged areas
Used to highlight areas tagged. Especially useful on large plans.
Option 3: Print ground cover schedule

This option draws the ground cover schedule. It displays the number of plants
required to fill each ground cover planting area at the nominated plant spacing
distance and links to the marker.

If the schedule is not quite drawn to your liking, it is possible scale the schedule.

The ground cover schedule is a block and if required can be edited in the usual way
by selecting the block and right clicking on it.

Edit schedule.
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Extract plant schedule

Once a design has been completed and a full planting schedule created, costing
can be extracted from the design. It is possible to extract species quantities from
the planting schedule and manipulate the data in spreadsheets such as Excel and

Google Docs sheets.
This movie show how to extract a plant list and import to Excel

This movie shows how to extract information containing costs to a file suitable
import to Excel.

You might use this technique to get data from list ready to send to a nursery for
quote.

Extract ground cover schedule

Export plant schedule to spreadsheet for
costing.

This option works in the same way as that described above and enables the
ground cover schedule to be passed to a spreadsheet.

gCADPIlus User Guide v2.0
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GPS

The gCADPlus menu contains an option to import external data in the form of GPS coordinate and text data.
Several options are available - import from a CSV file and import from Garmin GPX files.

GPSin

This option takes data in a standard comma separated file and based on information contained in the file puts
a point marker entity at each location. The import tool provides a dialog box that is used to determine which
comma separated zone is used for the x, y and z value for the point entity. A text label can also be added to

the point.

If the CSV file has a header row, the header value can be used as an aid for data selection.

GPS import options.
e — e ————— —— R — — ]
|x|' .‘ = |w Test2 - Microsoft Eacel
m Hiomme Insert Page Layout Formulas Diata Review View Sdd.Ins Acrobat
.i ) Calibi T c N T | B = Wirap Test GEnarsl tﬂt % ;y um
B I My = = | & B | N =T B Conlsr = L - -k -_W Condilianal Format Cill Tk @il
J u ﬁ i Mere il g e ~ Fomatting = as Table = Styles = i
Cliphoard Fomt . Alig nemee vt Humber SEples
a1 - £ tres#
Assign data columns. = - - - z F = = | ; - 7 =
1 [treew Ia.p-H.'iz: X Trunk ciru DBH (m] Height [1Health  Structure Maintena Retention TPZ radiud TPZ area  [m®)
2 1 Eucalyplu HZI110.3 61557 significant 0.53 16 Good Good Prundg High s 127
3 2 Eucalyptu HI117.2 61515953 significant 0.65 16 Good Good Prune High 1.8 191
4 3 Eucalyptu J82145.3 6152932 significant 063 18 Good Good Prune  High 6 180
5 4 Eucalyptu 2821028 S152977 significant 0.52 14 Good Good Prune  High i 127
] 5 Eucalyptu 2820859 6152977 significant .42 4 Good Poor Remove Low 5 &0
7 6 Eucalyptu J82151.2 6152960 significant 0.43 10 Good Average Prune Madium 5.8 104
] 7 Eucalyptu 282081.3 6152950 significant 0.52 14 Average Good None High b2 122
3 § Eucalyptu 282070 6152975 significant 0.53 15 Good Good Prune  High 1 157
10 9 Eucalyptu 282060.2 6152983 significant 0.78 16 Good Good Prune High 5.4 275
11 10 Eucalyptu 2830515 61525391 significant .86 20 Good Eood Prune  High 1.3 335
12 11 Eucalyptu 282060.1 6152969 significant 0.78 18 Good Good Prune  High Gl 275
13 12 Acacia sall 282075.1 6152357 significant 0.44 B Good Poor Remowe Low 33 BB
Sample CSV data file.
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It is possible to load a base survey map and overlay with data from a CSV file generated during a survey. Here
is a typical base map showing a wetland and accompanying cadastral information on roads and allotments.

In this example, we run the GIS tool, select the CSV file and the data is plotted on top of the base map.

Tip: In this example, we ran a custom version of the generic GPSin command, colouring trees according to Plotting tree health data.

health.
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The standard GPSin command in gCADPIlus will import the first four columns in the data set.

Record 1 in your file should show the header information, then the routine will import column A (numeric), Column B (text), Column C (x coordinate) and column D
(y coordinate). The remaining columns are ignored. A point is plotted at the x,y position and text written in the current style nearby.

Import Garmin GPX

This option takes a standard Garmin GPX file and imports the data, putting a point marker at the location the GPS value was recorded.

Import GPS track

Many landscape designers and horticulturists carry smartphones when they are inspecting a new site. Many have some type of GPS capability. Location data can be
easily gathered and used to orient and help orient and create a base plan in CAD software before a visit. This small application is available for the iPhone. It enables
an users to capture the latitude and longitude at any desired location. The figure below shows the [Phone screen and the shortcut to the App together with a copy of the
first screen page in the App. Note the information available - latitude, longitude, sample time, elevation etc.

In this instance, tracking has been started and the Stop Tracking option is about to be selected.

Switching the view to ‘Map’ shows the location superimposed over a Google Earth images. This image (and others showing the complete house block) can then be
emailed from the phone to the designer’s home base email address while they are on site. Google klm file information can also be exported from the smart phone
application as an aid in registering Google Earth images and GPS data.

The GPXtrack option takes a data file from the phone and will plot the points recorded by the phone.

GPSTrack
application. GPSTrack Google
Earth.
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Store extended data

There are times to when it is useful to store extra non-graphic information with symbols used in a landscape plan. For example, it might

be advantageous to store behind a furniture symbol, the details of size, cost, manufacturer, material used in construction. In the same vein,
GPS and Google Earth and photographic information about species symbols might also be required. The CAD drawing containing this extra
information then becomes much more than a simple replacement for a drawing board. It is possible to store extended information behind
any entity - lines, arcs, blocks etc. are all candidates for stored information.

This movie provides an overview of how extended data is manipulated.

Although it is not obvious, the design shown below contains a considerable amount of extended information. Details of outdoor furniture,
seating, paving, irrigation design are all there but only appear when required

gCADPIlus User Guide v2.0
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Furniture data

For example, you may have specified outdoor furniture from a particular
manufacturer in the design. It would be useful to store manufacturer name, type

Outdoor furniture data.

and cost of the furniture shown above. The figure
below shows a furniture block in a gCADPlus
drawing with extended entity information about that
furniture set. This information is not printed, but can
be displayed on cue.

Paving

A design may well call for an area of paving outlined
by a polyline. The STOREDATA feature is used here
store information about the supplier, paver size/type,
cost/paver etc.

Paving data.
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Decking

The example here store information about a quotation for a custom build of some decking/seating around the
base of a tree.

Decking data.

Irrigation
The length type and supplier of irrigation equipment is stored.

Irrigation data.
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Grass
Total area to be grassed, the type and company contracted to lay the grass are available.

Data on grass.

Lighting
Important information about lighting data can also be stored.

Lighting data.
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Species

The species option of the extended data tool allows storage of considerable extended information about
particular plants. Although not used in the example below, if gCADPlus was being used in (say) a botanical
gardens or arboretum, information on Google Earth location and GPS data can be recorded along with species
information in the extended data dialog box.

Species data.

View extended data.
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Google Earth
The species data dialog box also allows storage of klm file information.

N

gCAD*

Store Google Earth kim
data.

Link to URL

gCADPlus features the ability to store a URL, a link to an external location as part of
extended entity data. In the example shown if a user clicks on the link to url button in
the species dialog box, they will be taken to an online database where information on

propagation methods for the plant is stored.

Tip: To display the information in real time, make sure that EXT tab is pressed and when
your mouse hovers over the entity, much of the stored data becomes visible. It works just like

a tool tip.

gCADPIlus User Guide v2.0
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Highlight extended data

If entities such as the circle outlining the canopy of a specimen of the Grey Alder
(shown below) contains extended data, this option can be used to highlight in
magenta color those entities in a design that have extended data associated with

them.

Show extended data.

Show symbol with extended data.

Extract stored data

This option writes all extended entity information contained in a drawing to a
CSV data file ready for spreadsheet analysis.

Propagate stored data

Use this option to update a block symbol with extended data. For example, if in
an arboretum, the same symbol had been used to indicate many instances of the
same plant species then use this tool could be used to update all instance of the
block to carry that same extended entity data.
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Export gCADPlus models to SketchUp

The sub options - Make SketchUp layers and Write SketchUp data to DXF were covered in some detail in chapter 3 of this guide -
“Drawing with gCADPlus”

Further reading:

http://www.plus.designcad.com.au/?q=node/191

Shadow

This tool enables a shadow effect to be applied to any entity in a gCADPlus drawing. It is particularly useful where some emphasis is
required for plant symbols (blocks). Again, chapter 3 provides extensive information on using this tool.

Apply shadows to symbols.
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Fill closed line with a pattern

It is possible to take any symbol (a gCADPlus block) and use this tool to quickly
flood fill the area with the symbol. The figure at right shows an area filled with

a generic symbol indicating ground cover planting. Spacing is controlled by left
clicking to indicate desired separation distance.

This movie shows the patterning tool in action.

Patterning can be applied to any symbol, even those blocks made ‘on the fly*.

Before (top) and after (bottom) using the patterning cover symbol inside a
closed polyline.

Patterning fill with a custom plant symbol.
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Copy symbol along line

This tool on the gCADPlus menu enables placement of multiple copies along a line at a fixed interval that you nominate. Use it when setting out regular planting such
as seen in orchards.

This movie shows the ‘Copy symbol along line’ tool in action.

Copy a symbol along a line.

Copse

This tool merges a group of overlapping plant symbols to indicate a group of similar species. You will lose the ability to assign species to the resultant group so do not
use when you want an automated plant schedule.

We show how to use the COPSE command to merge a group of symbols into a simpler group. For example, the tool might be used where shelter belt planting is
required. Simply place any gCADPIlus symbol as an overlapping group and use the gCADPlus menu and select COPSE. This strips the complexity from the symbol
and leaves a marker in the center of each plant. That central marker can be altered at will to suit your particular need
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Insert Google maps/Image

There are times when it can be convenient to incorporate satellite images taken from Google Earth into landscape drawings. Provided that you are connected to
the internet, use Gppgle Earth or Google Maps to download satellite images and use Draw > Insert Raster and scale the image so it becomes part of the drawing
environment..

Here is a short movie showing how place Google Earth images into gCADPIlus.
As shown in the movie, start Google Earth, set the option that prevents tilting as zoom. Zoom in to your site. Save the image file and edit inside an image editor.

Start gCADPlus use Draw > Insert Raster.

Paste the image - either into a layout space or into model space. We suggest using model space if you want to scale the image to match the real world units that you are
using for the site.

Tip: it can be useful to paste the image onto its own layer. That layer can then be turned off if image display is not required.
< S < "

Here is another example showing a Google Earth image being used to assist in irrigation design work.
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Other users (especially in the environmental mapping and farm management
fields) will add vector information and perhaps extended entity information. The
figure below shows extra information added to a circle representing a Canary Date
palm.

Tip: Use the STORDATA command to link to a URL for extra (Internet based)
information.

If you have enough information about x and y coordinates and latitude and
longitude, it is possible to register the Google satellite image with vector data that
you add thus creating another type of hybrid image.

Save the resultant png image

file.

Image held by image file
manager.

Image in gCADPlus.
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Google Earth image as a
location plan indicator.
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Hybrid satellite/map and CAD landscape plan
information.
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Plant palettes

Rather than continually adding new symbols to gCADPIlus and thus making the gCADPlus setup file increasingly large, we have provided a section on our web site a
series of palettes (single drawings containing many symbols) that can be downloaded and used to add additional gCADPIlus symbols to your copy.

How to use the plant palette tool.

More information on palettes can be found at https://www.designcad.com.au/wp/how-to-add-extra-symbols/

Download extra
symbols.
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Some of the palettes available for download from the gCADPIlus web site are shown below.

Assess a site..

Climbers. Filled/Colorful
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URL entity

Use this tool to enable text in a design to link to an external a URL web address. Typical use might be to link to a manufacture’s web site for a piece of landscape
hardscape that has been specified for a design. Text in a title block in layout space might also link to the designer’s web site.

Note that only Windows text can link to a URL, CAD text cannot be linked.
Tip: When setting a URL, make sure that you include the http:// in the URL reference.

Write block

This tool is used to ‘lift* an entity or group of entities from a drawing and make a separate drawing of them. It is the equivalent of the WBLOCK (write block)
command in the AutoCAD environment.

GIS

The term GIS describes any information system that integrates, stores, edits, analyzes, shares, and displays geographic information. gCADPlus is certainly capable
of doing that. It is possible to load files from the the most popular commercial GIS system (ArcInfo) into gCADPIlus. In addition, tags can be added to any entity in a
drawing GIS tags and tools to work with SQL queries are being developed.

|

‘n.'
’ ‘7

\ A

gCADPlus can load
Arclnfo shape files.
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Customizing gCADPIlus for greater efficiency

Drafting efficiency can be inproved by customizing the gCADPIlus environment. Template, plant data files, text styles and the path to your own symbols can be stored.

This movie shows how one user customized gCADPlus for greater drafting efficiency.
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SppDb and gCADPIlus

We have developed a personal plant database application called SppDb that’s designed for use with gCADPlus. SppDb is designed to hold information about plants that
you know and work with. Both SppDb and gCADPlus can be run at the same time. Commonly, gCADPlus users will switch to SppDb and use it as a memory jogger
to find a species suitable for a particular landscape need. They will also copy images from SppDb and paste into a gCADPIlus layout page.

SppDb can also be used to generate a list of species for (say) a particular climatic zone or flower color. The list can be exported as a .gcp file that’s capable of being
read by gCADPlus. Once symbols are linked to individual species and a plant schedule created, the GOTSPP command can be used to establish a two way link.

Here is a small movie showing bidirectional data flow between gCADPlus and SppDb.

We export gCADPIlus plant schedule information to a CSV file, switch to SppDb and print a PDF file containing details and images of
all species used in the design.
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Tools

The Tools drop down menu provides some useful tools to speed drafting and
editing. The following are available:

Distance

Area

Measure & label closed polyline
Add up lengths of polyline series
Selection (All, un-select, Select by Current Layer, Select by polygon)
Draw Order (bring to front/back, bring above/below object)
Purge

Drafting Settings

Drawing parameters

Global parameters

Make Raster

Plug-ins

Plant Database

Sustainability Calculator

Merge PDF

Spot elevations

Setout Point Marker

Draw point table

Extract Point Marker data to Excel
Insert grid lines

Draw Section

Isolate Layer

AutoCAD compatibility checks
Switch Language.
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Distance

This command, found on the top of the Tools drop down menu and on the standard toolbar [or activated simply
by typing DIST in the drawing editor], asks for a start point for a distance measurement and a second (end)
point. The distance between the first and second click is reported both in the command area and on the screen
at the cursor point. When a third point is added, the running length is calculated so you could for example use
distance to measure total lengths of irrigation piping. ,

Tip: Use object snap to provide accurate start and end points for a distance measurement. Although it may
appear during the operation that you are adding entities or selecting them, these do not form part of the
design.

This movie illustrates the use of the distance command.

gCADPlus User Guide v2.0

Measuring distance - use osnap to locate points

The area tool.
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http://youtu.be/ArGP3TmIsu0

Area command

The area command (selected from Tools, the standard toolbar or started from the command area or by typing AREA), sets a yellow shape over what can be quite
complex areas. Entity snap tools can be used to precisely mark points on the perimeter of the area to be measured if precision is needed. The value for area will be
reported in the command line in square units - mm square, m square or square feet depending on the base unit in use.

Using an area value

The value reported can be copied from the command area (use Control C combination or Command C on the Mac), the single line text or leader command started and
the value pasted into the text box.

Tip: After the copy, round off the value to a suitable number of decimal places.
The area command has many uses. Like the distance command, when accurate measurements are required, it should be used in conjunction with osnaps.

Here we show how to use the area command to work out the area of a dwelling in a design by a firm of arborists.
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It is worth repeating that although it may appear during the operation that you are adding entities or selecting them, these do not form part of the design.
Measure and mark the area of closed polyline (and label)

This tool calculates the total area enclosed by a polyline and labels the area. You might well use it to calculate volume of mulch required for planting beds by
multiplying the area value by depth of mulch.

The mark area and label tool.
This movie shows how to mark the area of a garden bed that’s contained with a closed polyline.

e gCADPlus User Guide v2.0 255

gcAD*


http://youtu.be/1SNE-KoA_uA

Tip: If you are working in the Imperial system, make sure that you have set your
units to decimal feet otherwise the area calculation will be incorrect.

The area text will need some editing to reduce the number of decimal points
reported. In the figure below, the area has been rounded off to two decimal places.

Set units appropriately
for your design before
using the tool.

The mark area and label tool.
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Total the length of a series of polylines

If you have a series of polylines and want to total the length, use this tool. The polylines do not have to be
contiguous and might indicate a complex set of irrigation piping that can be totalled in one step.

Total length of irrigation
piping required.

Selection

Various methods for selecting and manipulating a selection set have been discussed earlier.
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Draw order - the entity stacking command

There is often a need to re-arrange the manner in which entities overlap. For example, mulching or paving would normally be seen at the base of a series of stacked
entities. Similarly, tall trees forming an upper canopy of a design might be seen on top of lower planting. In order to cope with this need to control stacking order,
gCADPIlus provides a tool to allow changes to be made to the stacking order of entities. One (entity) object can be set to lie under or above another if required. Options
are: send to the back, bring to the front, and for more subtlety, send above or below an entity.

This movie shows how to change the stacking order of a group of entities.

The Tools>Draw order option can be used to change the stacking order of entities.
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Purge

This option removes unwanted blocks (commonly symbols, but other blocks as well) from the drawing.
Drafting settings

These were discussed in an earlier chapter.

Global Settings

It is possible to make permanent changes to the way in which gCADPlus behaves; alter selection color, size of
cross hair cursor, shift to add and so on.

Here we discuss making global changes to the gCADPIlus drawing environment.

The Tools>Global Parameters option can be used to
permanently change the behaviour of gCADPlus.
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Make raster - export a bit mapped image file

It is possible to export raster images from gCADPlus drawings via Tools>Make Raster. A number of image file
format is possible and the resolution of each type of image is controllable.

. Windows BMP (these will be relatively large files)

. GIF (Web format)

. JPEG, (Typical of images from low cost cameras)

. TIFF (image type from expensive cameras - un-compressed; large file size)
. PNG (Web format)

This movie shows how to export raster images from a landscape design for a ‘modern‘ garden.

Exporting a raster image from gCADPlus.
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Plug-ins
The enhance gCADPIlus functionality and have been discussed earlier.

Plant databases

There are a number of different ways to work with plant databases in the gCADPlus environment.

SppDb - Species Database
We have created a separate Windows application called SppDb that’s designed to work with gCAD+.

Here is a link a short YouTube movie showing how to use SppDb it with gCADPlus.

Using SppDb with
gCADPlus.

Tip: It is important to note that SppDb is designed as a personal plant data file to work with plants with which you are already familiar
so you can find species for a particular need. It also stores information about hardscape elements so you can paste images into plans to
illustrate concepts. Once installed, SppDb is called from the Tools drop down menu and appears in its own window above the drawing as
shown below.

The database floats in its own window. Use the search facility to find species with the characteristics you want and export the list to

gCADPlus as a gcp file or copy the link to an image file and paste it into a drawing.
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Using native gcp plant database files

As part of the gCADPlus drop down menu, the gCAD+ also loads, edits and works with its own internal plant lists. A substantial list of
plant species called GardenCAD is part of the gCADPlus application. It is used to automate the production of planting schedules. The
figure below shows the sample gcp plant data file supplied with gCADPlus loaded into the drawing editor. In order to generate a plant
schedule, each symbol in the design is assigned to a particular plant species. There are tools to edit the list, save it to another name and to

edit records in it

We have included a spelling checker in the gcp plant database tool. The red underlines in the figure above show those species names that
have not yet been added to the dictionary. Adding new species and checking spelling

is an important step to ensuring that botanical names quoted in an automatically generated plant schedule are accurate. These plant list files

are associated with each design. It is possible to attach unique files for each job or attach a more general list.

3. Online web databases

gCADPlus User Guide v2.0
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There are a great number of plant databases available online. A particular favourite of ours is an English
database ‘DeepRoot’ which contains an exhaustive collection of images of thousand of plant species. DeepRoot
can also be used in association with gCADPIlus drawings. A web version of DeepRoot is also available.

DeepRoot - a massive
online database.
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Sustainability calculator

This tool provides a mechanism for a structured approach to assessing a landscape designs for sustainability and runs in its own window floating on top of gCADPlus.
A number of questions are posed, each asks for an assessment of how well a particular ‘sustainable‘ characteristic has been dealt with.

A movie showing how the sustainability tool is used.

Each question is rated with a score ranging between 1 and 10 and the calculator adds the total and calculates a sustainability index. As a question is answered, a tick
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appears in a check box. If the question does not apply to the design being assessed, leave unchecked.

The figure below show the first question. Here you are asked to make an assessment of the proportion of the landscape area that is open to penetration of rainfall, i.e.
provide an estimate the percentage of permeable surfaces. A site in which there is a high proportion of permeable surfaces will score highly on a scale of 1-10.

The second question is shown below. Here you are asked about the species chosen and their reliance on extra watering. If all species chosen in the planting plan will
survive on natural rainfall after the first year, score highly.

The calculator keeps a running total and at the end of the series of questions presents an overall score. We suggest that a score > 50% means that reasonable attention
has been paid to ensuring a sustainable landscape design.

Tip: Some questions may not be appropriate for every design. These can be left unchecked.
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Sustainability - some thoughts from Ross Uebergang - www.rossu.com.au

Sustainability in the landscape is a must. We live in a world of finite resources.

. Reflect: If I want a deck, do you really need one this size? How often will I have 80 people on my deck? Could I go without or could I use a substitute.
. Reduce: Can I set my areas up to use less energy?

. Refuse: If what is proposed is a bad idea say no. You may not need it or there may be a suitable substitute.

. Reuse: In the rebuild, is this material really at the end of its useable life? Can I find another use for it? Can I find someone else who has a use for it?

. Recycle: Can this material be processed to have a new life? This is the next alternative to reusing. Can I use a recycled product instead?

Living chess board -
design and construction
by Ross Uebergang.
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Tips for gardeners

Mulch and Compost - Go to a local landscape supplies centre and use their courtesy trailer or get it delivered. The mulch will mean less watering, better soil structure
and healthier plants while limiting the amount of weeds that pop up in your garden and spread throughout your neighbourhood. Depending on the style of mulch you
choose you could spend as little as $30 per 10m2 if you use your local council mulch, or around $60 for decorative mulches. Compost will create healthy soil that
needs much less additives.

Choose sustainable materials - If you must put in hard surfaces like decking, paving, pergolas etc, choose materials that have low embodied energies. This is the
energy needed to extract, manufacture, transport and install your product. Not only should materials you use in the landscape be low embodied they should also have a
reasonable longevity. A fantastic choices for low to medium use paths are local toppings.

Limit the use of hardscapes - How often will you actually have 80 people in your backyard to fill a massive deck? Consider if the space could be filled with plants
instead.

Line your fences with Fruit Trees - Fruit trees keep on giving with low maintenance. If you don’t have the time to be putting in vegetables every 12 weeks and
maintaining a vegetable garden, perhaps fruit trees are for you. They require limited maintenance and you do not have to replant every season. Each year more dwarf
varieties come out that take up less space which is fantastic for the small garden. Generally in the Australian garden, fruit trees require sun for most of the day to
provide fruit that is plentiful and tastes good. A fence line is a great spot to find this sun.

Can I fix it? - Your deck might be looking a little ragged at the moment but perhaps all it needs is a smarter choice of decking boards. Perhaps it just needs a fresh coat
of oil. Maybe a coat of paint on the back fence will revitalise the plantings that you have in front of them.

Cube seat - design and construction using recycled
materials by Ross Uebergang.
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Merge PDF

If you have produced a series of PDF files matching each of the layout sheets, this tool can be used to
gather those PDF files into one file ready to e-mail to a client.. Click on the image below to view a sample

presentation.

This movie shows how to use the MergePDF tool.

-

~

Project:

MELBOURNE INTERNATIONAL FLOWER AND GARDEN SHOW
ACHEVABLE GARDEN 2015

Location

CARLTON GARDENS

DWG Title

Landscape Series

Client

Nursery & Goarden Indus-l-r\/ Victoria

Drawn By

AK

Date

9 May 204 Job No 003

Scale

120 & A4

Rev

DWG No

Copyright (C) 2014

BURNLEY LANDSCAPERSJ
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http://www.designcad.com.au/BurnleySubmission.pdf
http://youtu.be/-1NhXvssanI

Points

A number of different point options are available:
. Spot elevation.

. Setout point/peg market.
. Draw point/peg table, and
. Extract point/peg table (to file).

Spot elevation
This enable a point to be placed in the design with a Z value set to it. This is in direct contrast to the usual spot
height markers provided by survey firms where the z value of a point is not stored.

Using the spot height marker.
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Setout point/peg marker

It is a good idea to keep the needs of your landscape construction team uppermost when designing. A point is
associated with a fixed coordinate position and is often used to place setout markers for a construction team.
the figure below shows a typical example. As can be seen from the properties box in the figure below, the entity
associated with numbers 41 - 46 is a point. The number itself is simply a pice of text. The POINTMARKER
command allows users to place a point entity and text.

Setout points defining a curve.

The first prompt presented when the point marker tool is chosen ask for a base point. Each point marker is
related to this base point. The default value for the location is coordinate 0,0, but it can be set to any convenient
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point in the design - perhaps the corner of a building.

To delete a point, start the POINTMARKER command and type “D”. When asked to select the point to delete,
wrap a selection box around the point. That is easier than trying to make a direct selection.

The construction team can then be provided with dimensions for each point so they can swing two arcs to
locate the point.

Dimensions can help construction
teams. Aligned dimensions in this

case.
ID command
There are occasions when you need to establish the x,y values of a location in the drawing. The ID command
does just that and reports the coordinates of any location (usually in response to an osnap) - a variation of the
command IDPoint, selects only point entities.
Insert grid lines
In common with many page layout document designers who use grids in Adobe’s InDesign, many landscape
designers prefer to design on a grid. The GRID command (found on the Tools menu) draws a grid over any size
design area and has the option of labeling the horizontal and vertical lines. Far from cramping the design style,
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a grid, especially based on the size of a dominant window in the building often helps unify a design and spark
new ideas.

The grid dialog box allows users to set the number of horizontal and vertical lines, grid cell size and the form of
text labels. The grid can be turned into a block and rotated to any desired angle. If the Intersection osnap turned
on, it can be a simple matter to layout a design.

The figures below show a design where a grid was used as an aid to set out grassed and other areas.

Using a grid as a design aid.
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Reference grids

If you are dealing with a large site, labeled grid created with the GRID command provides a method of referring to any particular zone
within the design. The figures below show an example from a site in metropolitan Melbourne. The grid has been drawn at 10 meter
intervals. Because the grid can be automatically labeled, a reference such as D3 can be used to indicate the location of a proposed fire pit

area in a landscape design for a large site.

The grid can be a reference to
location.
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Here is another example of the use of the grid tool. A reference grid has been set up for an arboretum of
Quercus spp in Southern Argentina.
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Section tool

An example of the use of this tool was given in chapter 3.
Isolate layer

This tool is used to select a layer and turns off all other layers.
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Check AutoCAD drawing

Legacy tool for ananlyzing an AutoCAD dwg file to ensure it can be written. Largely supplanted by our DXFin
and DXFout tools.

Clen up AutoCAD file.
Language switching

The use of this tool has been covered earlier.

e gCADPlus User Guide v2.0 275

gcAD*



More on coordinate systems
In common with other CAD software like AutoCAD, Vectorworks, MicroStation etc., gCADPlus works with a coordinate system. Looking at the figure below, positive
X is to the right in the drawing editor and positive Y up. Entities can be placed into specific coordinate position and the database keeps track of the position and stores

a new set of coordinate values, even if the entity is moved.
This movie discusses the coordinate system used by gCADPIus. We show how to draw line of accurate length using pairs of coordinates (called Cartesian

coordinates) and draw lines of defined length at different angles.

Using Cartesian coordinates in CAD drawings.
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Beginners often have some difficulty understanding the different coordinate systems available in gCADPlus.

This movie explains the use of absolute and relative Cartesian coordinate systems along with absolute and relative polar coordinate systems using a typical
landscape design file using metric units.

We show how to draw lines of required length in the landscape plan shown
above.
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https://youtu.be/QUAR8idtAQo

Dimensioning

This chapter focuses on the use of dimensioning in CAD drawings. One of the most important and often under-rated aspects of any CAD program is the ability of the
software to place appropriate dimensioning into the drawing so that the design may be built by a construction team.

Here is a small movie demonstrating the application of some some simple dimensions in a gCADPlus design. We then switch to a ‘proper’
landscape design for a remembrance garden and show how the designer can provide enough dimensional information for the construction
team to build the job.

The drawing database

Like other CAD software (AutoCAD, MicroStation etc.) gCADPlus creates a database as the drawing grows. It accesses this database whenever dimensional data
needs to be added to the drawing. Just as accuracy is important when creating a drawing, it is also important when adding dimensions. There is no point in drawing
accurately and then being sloppy when adding dimensions. Care must be taken, and osnaps should be used when placing dimensions.

Tip: If you always draw full size, as we have emphasized in our gCADPlus training materials, then you can (and should) let the software take its dimensioning from

the model that you have constructed.at inputting details of site location, scale and so on becomes a straightforward process.

Some examples of dimensioning applied to

a gCADPlus drawing. The dimensions have
been placed on thier own layer so they can be
displayed in a layout space.


https://youtu.be/NEIqZj-NmFo

An example of dimensioning in a
gCADPlus design from the USA. Here
the base drawing unit is decimal feet.
If needed, the dimension style can be
edited to display dimensions as feet
and inches.

This movie shows how to use the linear dimensioning tool to apply dimensions to a drawing for a site in the USA where the base
unit is decimal feet. The dimension style used automatically expresses the final value in feet and inches.

1t is possible, but not normall desirable to
override dimension value. In this can the path
section has been broken and the path width is
shown as 1000 using an override.



How to place dimensions

The figure below provides some guidance for the application of linear dimensions to a plan view. While the actual dimensions shown here
might not be the units you would use, the positioning, distance from model, arrowhead sizes etc. are common to all dimension work. So
dimensions are used to show the measurements of objects, the distances or angles between objects, or the distance of a feature from an

origin you specify.

Dimension types
CADPlus provides three basic types of dimensioning: linear, radial, and angular
Linear dimensions can be horizontal, vertical, aligned, rotated, ordinate.

Note that it is possible to dimension objects, such as lines, arcs, circles, and polyline segments, or you can dimension between point
locations.

Every dimension assumes the current dimension style, which controls characteristics such as arrowhead style, text location, units format,
etc. With dimension styles, you can make subtle modifications to a base dimension style for different types of dimensions. The figure
below shows a timber screen in plan view with a dimension applied indicating that the screen is to be 2 meters long.

Note that gCADPIus places dimensions on the current layer, but it is a good idea to put dimensions on their own layer. We suggest using



the layer name L-DIM in line with a published standard.

Every dimension assumes the current dimension style, which controls characteristics such as arrowhead style, text location, units
format, etc. With dimension styles, you can make subtle modifications to a base dimension style for different types of dimensions.
The figure below shows a timber screen in plan view with a dimension applied indicating that the screen is to be 2 meters long.

Examples of the use of dimension styles in landscape drawing

This movie shows how to use dimensioning styles to achieve a desired end result.

This movie shows how to use a special gCADPlus tool to stamp a value for a lawned area. We then use the linear dimensioning
tool to apply dimensions some steps. The design is for a site in the metric environment where the base unit is millimeterst. The
dimension style used automatically expresses the final value in an appropriate number of decimal places.

This movie shows how to the dimension leader to add quite a detailed note to a typical landscape design.

We discuss the properties of individual leaders in a design - changing the justification and landing length of leaders

Simple techniques for labeling symbols in a landscape plan. We start by using single line text and placing text in the middle of a
symbol. Then we show the value of using a leader to annotate a landscape design, changing the type of end symbol in the leader.
Then we show the use of the smartlabel command
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